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Preface

Thank you for buying our products. Our machine is professional and
high-technology equipment combined with the optical, mechanical and electrical; here
especially edit this manual for your good operating and maintenance.

We also take many real object photographs in the manual; it helpfully introduces
installation & adjustment, maintenance, safety attention etc. in details.

The user should read this manual in details before using, because it will help you
have a good grasp of operating and maintenance.

Welcome to provide your valuable comments or suggestions, will highly

appreciate it !
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| Manual of laser machine
Statement

1. Any differences are not specially notified in advance for products update etc.

reasons.

2. All products according to the real object, manual's photograph maybe different with

real object for products update etc. reasons.
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Safety Note

% The users should read the related operating manual carefully before operating. Must
obey the operating regulations strictly.Non-trained people are forbidden to operate
machine.

% The machine uses IV LASER (strong laser radiate),this kind laser radiation might
make following accidents:

(DEasy to burn around combustible materials; (@Different working materials might
produce other radiations and toxic or harmful gases during laser processing; (3Laser

radiation's direct sunlight will cause body harm,;

The machine location must equip fire-fighting equipments, so forbidden something
combustible and explosive around the machine, keep drafty. Non-trained people are
forbidden to operate the machine.

% Processing material and emission should conform to local laws and regulations

% The user should consider carefully whether processing materials are suitable for
laser working for risk reason.

% There are high-voltage and other potentially dangerous in the machine, non
professionals are forbidden to disassemble machines.

% The operator is forbidden to leave during operating and must cut off switch when
finishing work.

% Forbid open any cover during working.

% Make sure the wire connects well with the ground before operating.

% Forbid the things inconnected diffuse reflection around the machine for fear the
laser light reflect the person or incendive directly (advice use firehosereel box in
location of working).

% The operator must observe carefully during the working of machine, if something is
exceptional, should cut off all the switch.

% Keep the machine in the dry place, non-pollution, non-concussing, non-strong
electricity, strong magnetism etc.,environmental temperature should be
5-40°C ,environmental humidity should be 5-95%(no condensed steam).

% The laser machine needs far from sensitive EMI equipment, it will make EMI to this
kind equipments.

% The working voltage: AC220V, 50Hz, it is forbidden to open machine when the
power supply voltage is unsteady or mismatch.

Manufacturer won't take any responsibility and liability because of improper use
and user not obey above all regulations.
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| Chapter 1 Machine Appearance and Accessories

1.1.1 Machine Appearance (Different model will have different appearance,
according to the real object)

1. Right side is shown in Fig.F1-1

F1-1

2. Back side is shown in Fig. F1-2

F1-2

1.1.2 Accessories set (according to the real object)
Your accessories set include following parts except machine (except option spare

4
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parts)

1. Water pipe (air pipe), Air pump, Water pump (some installed in water tank), is
shown in Fig. F1-3:

&SP RESUN

L L Aol ELECTROMAGNETIC
iR PUMP

AGUARIUM LIQUID FILTER J &

F1-3
2. Exhaust fan, smoke pipe, is shown in Fig. F1-4:

w e

F1-5
1) Water tank (less model not provide water tank), is shown in Fig. F1-6:
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F1-6
2) Manual Bag and inside accessories, is shown in Fig. F1-7,F1-8:

F1-7 F1-8

6. Ground Wire is shown in Fig. F1-9(customer need to prepare it by yourself):

F1-9
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| Chapter 2 Installation and Commissioning of the Machine

A complete working system is composed by laser engraving machine, the exhaust fan,
air pump, water pump, water tank, exhaust pipe, data transmission lines and so on.
According to the needs, the users can configure the computers, printers, scanners and

so on by themselves.
l. 2.1 Installation and Adjusting Steps
1. Laser Tube Installation

As the laser glass is fragile goods, the laser tube should be packed separately in order
to ensure its safety during the transportation. So the users must install the laser tube
before machine installation and commissioning.

Laser tube should be mounted on the back of the machine, open the protective cover of

laser tube; you can see the two Vee-blocks. As shown in Fig. F2-1:

e

F2-1
Put the light-emitting window (low-voltage end)of laser tube with the same side of
No.1 reflector mirror on the Vee-blocks carefully, and then latch on the rubber strip on
the Vee-blocks wear of laser tube , fix laser tube well. As shown in Fig. F2-2:

F2-2
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Attention: (DThe laser tube can’t be fixed too tightly to avoid damaging it; @Be sure
to keep the water inlet (laser tube high-voltage side) is located at the bottom of tube to
keep the water filling the laser tube fully.

After Fixed the laser tube, the water inlet pipe which connect with water sensor should
be connected with the high-voltage side water inlet mouth of the laser tube; the water
outlet pipe should connect with the low-voltage water outlet mouth of laser tube (if the
weather 1s cold, ,in case of break the laser tube, we’d better scald the end of the water
As shown in Fig. F2-3, F2-4:

#

pipe with boiled water to make it soft. ),

F2-3 F2-4
All the connectors must be butted firmly to prevent water leakage. The rubber pipe

must be straight, can not be curled in order to avoid poor water flow.

Finally, let the high-voltage cable of the laser power supply connect to the
high-voltage side post head of laser tube, the low-voltage cable of laser power supply
connect to low-voltage side post head of the laser tube, as shown in Fig.F2-5 F2-6:

F2-5 F2-6
For security, please seal the post head of the high voltage side and low voltage with

silicon gel.
2. Water Pump Installation

Please fill pure water into the water tank (the water level should be higher than the
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pump at least). Let the water pump outlet connect to water inlet of the machine, using
another piece of water pipe connect to the water outlet of the machine ,and put the
other side of this water pipe into the water to complete the circulating water piping
connection. As shown in Fig.F2-7, F2-8:

F2-7 F2-8
Connect the water pump power supply, at this time we can see that the laser tube is

gradually filled with water. If the water can through the water outlet pipe smoothly, it
shows that the pump is working properly.

In order to ensure the cooling water flow of the laser tube normally, a water protection
sensor is installed in the water recycling system, when water pumps working poor or
abnormal, the laser engraving machine will come into the protection state
automatically. Then the laser tube will not emit the laser light. Therefore, in the course
of routine maintenance, you should pay attention to the clean water pumps and water
pipes.

3. Installation of Air Pump

Make the air outlet of the pump connected to the air inlet of the engraving machine
with air pipe; ensure the outlet can vent air normally after turn on the power. As
shown in Fig. F2-9, F2-10:

F2-9
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Air pump is very important in the system. High-pressure air runs through the air pump
and blew out from the laser light-emitting window of the laser head. On the one hand,

it can ensure the cleanliness of the focus lens, on the other hand, it can prevent the
material inflame by the laser light. Therefore, in the routine maintenance, the user
should pay attention to the air pipe, must ensure that it can not be twisty or damaged,

otherwise abnormal air may lead to burning materials.
4. Installation of Exhaust Fan

Connect the blue smoke pipe to the dust suction outlet of the engraving machine, and
fix them with lock. And put the other end of smoke pipe to outside. As shown in
Fig.F2-11:

F2-11
5. Safety Grounding

Morn laser engraver uses fourth type of laser tube. The type of drive is
high-voltage-driven, so during users use the machine, they must comply with the
"Safety Note ". On the other hand, it asks stringent requirement about the safety
grounding to the users. The safe Line-to-Ground Resistance should be less than 5Q.
Specific connection method are shown in Fig.F2-12, F2-13

K
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Attention please, bad grounding can cause high failure rate of equipment and at

the same time may cause other safety incidents! ! !

The company won’t assume any responsibility and obligation to the fault and the
accident caused by bad grounding!!!

6. Optical Path Adjustment

After let all power cables connect well and electrify, turn on the engraving machine
power supply, at this time, the machine starts to reset and return to the last origin
point . All above shows that the machine is running normally, then turn on the laser
power supply, begin to adjust the optical path. As shown in Fig.F1-14:

F2-14
Firstly, adjusting the laser position. Make the multilayer adjusting paper stuck on the

1# mirror frame, and then push the "Pulse" key on the control panel. There will be a
burned point in the paper, check whether the light spot is in the center of the mirror, if
the light spot is not in the center o f the mirror center, we have to make the light spot
in the center of the mirror by regulating the location of the laser tube.

Then adjust the 1# reflector mirrors. Move the beams to the nearest place to the
1# reflector; push “Pulse” to get a spot in the paper. And then move the beams to the
farthest place from the 1# reflector, get another spot in the paper. We adjust the angle
of the mirrors by adjusting the three screws on the back of mirror (clockwise rotation
the above screw, the spot will be down; clockwise rotation of the lower left corner of
the screw, the spot will move to right; clockwise rotation of the lower right corner of

11
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screw, the spot will move to left.), to insure that all the spot are in the same place in
the paper when and where the beam we move.

After adjust the 1# reflector mirror well, the next, adjust the mirror 2# as we do at
the first step, move the laser head to the nearest side to 2# reflector , then make a spot
in the paper , then move the laser head to the farthest place to 2# , make a spot. We
have to adjust the further spot overlap with the first spot by adjust the screws on the 2#
reflector frame.

Note: As the best, the location of light spot should be in the center of mirrors. The
light spot can not hit the edges of the mirrors. If playing in the edges, please
continue to adjust the mirrors until the light spot in the central of them.

At last we have to check whether the light spots are superposition wherever the
laser head is. If the spots can not coincide, please re-adjust the optical path by the way
we talked above until the spots coincide

After finished the adjustment, we will check whether this laser spot is playing in
central of the laser head light hole. If not, turn off the laser power supply, adjust the
laser tube position. If it is left and right excursion, which side is biased on, we move
the laser tube to this side direction. Such as: if left, we adjust the laser tube to left ; if
right , we adjust the laser tube to right .

If the migration is up and down, we have to adjust the laser tube to the opposite
direction, that is, if up, we will make the laser tube down; if down, we will make the
laser tube up.

Note: The above adjustments is just for a low-voltage side of laser tube (light side),
if we want to adjust high-voltage side of the laser to achieve the same effect, then
the adjusting direction is opposite.

The detailed description of how to adjust optical path, please see Chapter 4
"Alignment Standards of Optical Path".

After adjustment of optical path, please close the laser tube protective cover.

12
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| Chapter 3 the Operation of laser machine

Besides use the computer to control the function key, we can use the Control
Panel. The following is the brief instruction of control panel and main function.
There are 16 function keys and one LCD Panel in the Control Panel:

1.3.1 Introduction of Main Interface
Main Interfacel (Idle)

File
Max Power:

Speed
Idle

Main Interface 1

Main Interface2 (Running)

Files : XXX
Max Power : XX.X%

Work Speed: XXXmm/s
Run ¢ XX: XX: XX

Main Interface 2

13
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Main Interface3 (Pause)

File : XXX
Max Power : XX.X%

Work Speed: XXXmm/s
Pause : XX: XX: XX

Main Interface 3
When the machine does not work, it will appear as ‘Main Interfacel’. The Present
file shows ‘000’ (it means not choose Memory File), we can see the Max Power and
Engraving Speed” from the LCD panel. The maximum energy expressed as a
percentage, accurate to 0.1 percent, the unit of the Speed is mm/s. We can press any
key under “Main Interfacel”, but some key will not work under “Main Interface 2”

and “Main Interface3”.
1.3.2 Introduction of key

(1) Reset

Machine will reset (or energized) under all statuses. The main board will reset and
the machine will come back to Work Original, and the LCD panel will show” System
Reset”. After return Origin successfully, the machine will automatically go to the last
Work Origin,

If the last work was finished completely, the LCD will appear the Main Interface
L.If the last work was not finished (the power was off when working), the system will
show like this:

Power Off Rework

OK
Esc

Interface 4
If we press “Esc” key, the machine will not work successive, and the system will
come back to “Main Interface 17; if we press “Enter”, the machine will continue work,
and engrave the picture which is not finished before the power off.
Note, after we press “Enter”, the LCD will appear "Search Power Off Point ,
Please wait ", the waiting time has relation with last processing data quantity, the more

14
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the data quantity is ,the longer the searching time is. Generally speaking, if the
power was off after the graph processed an hour; the searching time is about 1 minute.
(2) Laser

We can Press this key when the machine under “Idle” and “Pause” status. When
we press this key, there has laser emit from the laser tube, the time of light is the time
we pressing this key, when we release it, the laser stop. We can also cut materials by
pressing this key and direction key. The laser power is the Max power on the LCD.
This key 1s unusable when under other status.

While the water cooling system does not work, there will be no laser. Also, there

will be an error message on the LCD.

st

There are three parameters keys: Min Power, Max Power, and Speed. We can

(3) Parameters keys

adjust the parameters keys under all the three main interfaces (Idle, Run, and Pause).
We can see the parameters on the LCD panel when the machine works. When the
software is generating the cutting/engraving file, if one of the parameter from Max
power ,Min Power and Speed or all the parameters set to 0, it will take the
corresponding parameters on the LCD which under the Idle status . Once start work,
there will appear the currently processing parameters of the layer on the LCD.

Take “Speed” for example, we can see the following screen when we press Speed
key:

Speed: XXX mm/s

OK Or Esc

Interface 5

We can pitch on the parameter which we want to adjust by left or right direction
key, and then change it by up and down key. We can save it by pressing “OK” key, and
cancel it by pressing “Esc” key.

The Min and Max power with the similar changes. When under Idle status, the
power and speed change will affect following operation parameters: track frame on the
keyboard, laser, manual shift axis, etc. Change these three parameters when the
machine is working, then just modify the ongoing effect of processing, do not affect

15



User’s Manual of Laser Engraving / Cutting machine http://en.shenhuilaser.com/
layer under the idle status of keyboard parameters and will not affect other layer

parameters.
On-line modification of the processing layer parameters, bring great convenience

to the users to find a reasonable laser power and speed matching.
(4) File

=1

We can see the following screen when we press file key when the machine under
the Idle status:

MemoryFile
UDiskFile

TrackFrame
Del All Memo File

Interface 6
We can pitch on the file by up or down direction key, then press “Enter” to enter
next file. It will show us no “file” if there is no file in “MemoryFile” or “UdiskFile”. If
there has file, we can see the name and information of the file on LCD Panel. We can
see four files on LCD Panel.

Interface 7
We can choose file by direction keys (up and down used to change the item, left
and right key used to change page), and then click “Enter” to enter next interface. It
supports the following four functions: ‘Run’, “Track Frame”, “ToUsb”, “Delete”.

Run
Track Frame

ToUsb
Delete

Interface 8
The machine will process the checked file when we choose “Run”, the file will
copy to U disk when we choose “ToUsb”, the file will be deleted when we choose

16
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“Delete”.

For files in U disk, it supports “copy” and “delete” two functions. If there is any
thing wrong, we can press “Enter” or “Esc” key to save or cancel it.

The main board can recognize FAT32 and FAT16 format files. But we have to put
these files in U disk root file. More than eight characters files are automatically cut off,
the name of the files must be letters or numeral. The files copied from the motherboard
to the U disk are placed at the root file.

"TrackFrame" option of Interface 6 means track border for the selected current
memory file (latest processed file); "Track Frame" option of Interface 8 means track
border for the particular memory file. Any one of these two options is selected, the

interface is shown below:

Blank XXX mm
CutFrame
TrackFrame

DotCorner

Interface 9

Get into the interface 9, the cursor is in the first option "Blank" by default (the
Blank is the extends outward distance on the basis of the actual size of the graph), at
this time, we can set the “Blank” by pressing the arrow keys. Then press the keys
“Enter” or “Esc” to set or cancel the setting. After we set the blank distance, the cursor
will return to the "Blank", we can select other options by pressing up and down arrow
keys. "CutFrame" can make us cut down the finished graph by hands; “TrackFrame”
means moving along the border to achieve frame preview; "DotCorner" means the
laser will emit at the four corners of the border, through the four spots we can view the
graphical size and location intuitively. At these times, the moving speed and the laser
power of the machine are the settings which appears on the LCD when the system is
idle (the laser power for “DotCorner” is only has relation with the “Max Power™).
Note: If the size of the graph is too large, or the location is very near to the
Max/Min coordinates, the border may be exceed the Max /Min coordinates. At
this point the interface will show “Exceeding” information, after press Enter key,
the system will track or cut down the frame according to the Max/Min
coordinates. For “.rd” file generated by older versions software, the interface will
show "No Frame "information when operating frame to “.rd” file. When start
border operation successfully, the interface will show "Tracking Frame ",at this
time ,the display won’t respond to any other buttons except "Reset".
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(5) Start/Pause @

Start/Pause can be pressed in three main interfaces. Press this key when the
system is idle, it will process the selected files; Press this key when the machine is
working, the work will be paused; Press this key in pause interface, the work will

continue.

(6) Origin

We can press the key when system under Idle status. The main board will take X/Y
axis position of current machines as start working point. This key is invalid in other
interfaces.

(7) Language (@15
Guage

Man-machine interface supports three languages. When the system is idle, press
"Language" key, enter the language selection interface, there are three languages:
"Simplified Chinese", "Traditional Chinese" and "English", select the language and
press the "Enter" key, then the LCD will display the appropriate language. Not
modified in the next language, the language selected last time will be effective
permanent before changing language next time.(even restart the machine).

(8) Esc. Enter

Pressing Esc or Enter keys can confirm or cancel the operating in every interface.
(9) Direction key (up and down, left and right)

(A] [ V] [en] [m)]

Direction keys are used to change parameters, move the axis. We can press

direction keys to move axis in Idle or Pause system interface. Moving X axis by
pressing left and right key, moving Y axis by pressing up and down keys. The
Maximum moving speed of pressing key is speed on the LCD when the system under

idle status

(10) Z/U key C]

Z/U key is available under the idle status.The interface will show as below after

pressing the key:
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ZAexsMove
UAexsMove

Z AexsReset
ManualSet

Interface 10

We can change cursor location by pressing up and down arrow keys. When
cursor stays in the "ZaexsMove", the axis will move when pressing left and right
direction keys.

If the step moving distance is 0,Z-axis will be continuous movement when we
pressing left or right keys; If not 0, Z-axis will move a certain distance when pressing
left or right keys. "UaexsMove" is similar as "ZaexsMove". When the cursor selects
"ZaexsReset" option, press “Enter”, the system will start to operate Z-axis back to the
origin, then the interface shows "Z axis is resetting", when the Z-axis reset finished
after finding the origin successfully, the same as X/Y axis, Z axis has Max/Min
coordinate protection, Z axis has a automatically acceleration and deceleration when it
moves in the Max/Min coordinates of the worktable of. When the cursor selects "step
set "option, press Enter, the interface shown as follows:

Step Moving Distance

XXX.Xmm

Interface 11

We can set it by pressing the arrows. The set of set moving distance set affects
four-axis step distance operation of X/Y/Z/U.
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| Chapter 4 Alignment Standards of Optical Path

During common use, there may appear some deviation with the optical path,
resulting in no laser or light path is abnormal, then please refer to the following
method to adjust the optical path:

Step one: First to ensure laser beam from laser tube to the center of 1# reflector

mirror.

Step two: Affix multi-storey double sticky tape paper on the 2# reflector (Or
other objects can be marked on), move laser beam to closest location of laser tube,
press pulse(choose suitable power),get a spot on the paper(with special attention: In
order to prevent the laser radiation wounding, with a piece of cardboard first to test the

approximate location of the spot, and then adjust).

1#
laser tube I:::I

Uy, 32

A#

Step three: Move away the beam to the position far from the laser tube, press

pulse, get another spot on the paper.
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1#
;&:ﬁ laser tube E:j

L 4

|
W 3%
24
A#

Step four: If the two spots are not superposition, adjust the screws on the back of
the 1#mirror to make the laser fire on the same position as the first spot.

Step five: Repeat the second to the fourth steps until the two spots overlap
completely. Moreover, the spots should be in the center of the hole.

Step six: Affix multi-storey double sticky tape paper on the 3# reflector ,move

laser head to the nearest position from 2# mirror, press pulse(choose suitable
power),get a spot on the paper.

I?e:j laser tube I:::I

2#

Step seven: Move away the laser head to the position farthest from the 2# mirror,
press pulse(first to detect the approximate location of laser with a piece of cardboard
to prevent wounding),get another spot .
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1#

laser tube I:::l

24

A%

Step eight: If the two spots are not superposition, adjust the screws on the back of
the 2# mirror to make the laser fire on the same position as the first spot.

Step nine: Repeat the sixth to eighth steps until the two spots overlap completely.
Moreover, the spots should be in the center of the hole.

Step ten: Affix multi-storey double sticky tape paper on the 3# reflector, press
pulse, get a spot on the paper. If it is in the center of light hole, then pass.
Step XI: If the laser light is not in the center of light hole, as below figure:

In the left Figure, the spot is upper and right biased.

Top to bottom bias: can only raise or lower the laser tube.

Inside and outside bias: only move the laser tube in or out to adjust.

In this case, it is essential to lower the laser tube (here refers to low-voltage side
of the laser tube), and then, from the beginning of all the re-adjustment of the first
step.
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Note: The operator can’t do the above working until after the professional
training. Otherwise, the operator do this working must with the help of the
professional .The operator must pay attention to security when adjusting, to
prevent the laser radiation wounding.

| Chapter 5 Daily Maintenance and Common Faults

The stable working of the machine is inseparable with normal daily operation and

maintenance. Here are some common daily maintenance and common faults analysis:
1.5.1 Daily maintenance

1. Replacement of the cooling water (clean water tank and replace recycled water
once a week are recommended):

Quality and temperature of the cooling water can affect the lifetime of laser tube
directly, suggest use purified water or distilled water, and water temperature should be
below than 35 ‘C.When higher than 35 °C please replace cooling water, or add ice
cubes to lower the water temperature,(cooling device is recommended, or use two
water tanks).

Note: To ensure that the laser tube full filled with cooling water before machine
working.
2. Cleaning of Water Tank

First of all, turn off power, disconnect the water inlet pipe, let the inside water of
the laser tube flow into the water tank automatically, open water tank, take out the
water pump, clean water pump and water tank, put the pump back to water tank, insert
the water pipe which connect water pump to water inlet mouth of the machine, finish
all joints, then replace cooling water. Turn on the water pump power supply isolately,
let the pump run 2-3 minutes (make laser tube full filled with water).

3. Cleaning of Exhaust Fan

After long time using, inside of fan will accumulate much solid dust, so the
exhaust fan will make a great noise, and it is not conducive to the exhaust .When the
exhaust effect become poor, we have to clean the fan and smoke pipe .Firstly, turn off
the power supply, remove the two pipes from the fan, clean dust inside of the pipes,
and then clean the dust inside of the fan.

4. Cleaning of Lens (daily cleaning is recommended before work, equipment must
be in shutdown state)

As we have talked before, engraving machine has three reflector mirrors and one

23



User’s Manual of Laser Engraving / Cutting machine http://en.shenhuilaser.com/
focus lens (1# reflector mirror is near the light outlet mouth of laser tube, the upper

left corner of the machine,2# reflector mirror is at left side of the beam,3# reflector
mirror is on the top of laser head, the focus lens is located in the bottom part of the
laser head),the laser is send out by the mirror reflecting and focus lens focalizing.
Mirror is easy to be dirty, resulting in laser loss and mirror damage, you needn’t
remove 1#,2# and 3# mirror when cleaning them, Just using a cotton bar to dip some
cleaning solution (acetone or alcohol), swab carefully by rotating from central to
edge of the lens.

Take out the focus lens from the laser head, using the same method clean it, after
cleaning, put it back.

Note: (O you should wipe the lens carefully, can not damage the surface coating;
2 you should do that lightly, to prevent falling; @keep concave side downward
when install the focus lens.

5. Cleaning of Guideway (suggest cleaning every two weeks, equipment must be
in shutdown state)

First of all, move the laser head to the far right (or left),wipe with a dry cloth until
shiny clean, together with a little oil (sewing machine oil is recommended),push the
laser head several times slowly along the guide, so that lubricant can be evenly
distributed. Clean and lubricate the Y axis two guideways is the same as X axis.

Note: Please prepare for cleaning Guide - dry cotton cloth, lubricating oil.
6. Optical path inspection

Optical path system of the laser engraving machine is completed by the mirror
reflection and focus lens focusing, and there is optical path bias with the focus lens,
but the three mirrors is fixed by the mechanical part, optical path bias is very possible
for them, although there is no optical bias normally, we still suggest you check optical
path before working.

Please get detailed explanation from Chapter 4 "Alignment Standards of Optical
Path "
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Phenomena
No. of Analysis method Solution
Malfunction
Check power supply of | Make all power supply
Open the | machine connects well or not | electrify again
1 machine but , — Correct the parameters
Mainboard parameter is right .
no movement ¢ according to software
or no
operating manual
Correct the laser
Working with | Mainboard parameter is right ,
2 parameters  according to
nonstop laser | or not ]
software operating manual
Check water circulation is| Clean water tank, water
Desultory .. :
, swimmingly or not pump and water pipe
3 light when
, ) Add regulator for the laser
working Voltage is stable or not ,
machine
Correct the X and Y axis
Self-test : . L " »
Mainboard parameter is right | direction  ,limit  position
4 abnormal .
) or not parameters  according  to
when starting ,
software operating manual
Check whether the data port
o Choose correct port
choice is correct.
Check whether turn on the )
After output , Turn on the machine
, machine
5 | data ,machine
, Check whether connected :
no action , , Connect ground wire
ground wire for the machine
check whether installed the| . _
) install the USB driver
USB driver
Check whether optical path is
No laser bi W P P Adjust the optical path
ias
6 when
. Check whether the cooling , _
working ) ) Ensure the water is running
water 1S running
Can’t detect |
TThe computer or USB|Change computer or USB
7 the laser

equipment

communication problem

line
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| Chapter 6 Warranty Regulations

I 6.1 Warranty Periods

From the date of purchase, whole year warranty (except consumables). Optical
lenses and the laser tube are consumables, three months warranty.

I 6.2 Warranty Clauses

This warranty is for products of our company.

During the warranty period and under the correct use, malfunction can be based
on this warranty terms, show the warranty card or invoice, enjoy our free maintenance
service.

The following cases, can’t enjoy the free service, a fee will be charged according
to the concrete condition.

1) Maintenance services not caused by the machine quality;

2) Overstep the warranty period;

3) Can’t show or alter warranty card;

4) Didn’t fulfill the contractual obligation;

5) Without the company agrees, privately to tear open outfit, modification,

maintenance of product;

6) Equipment failure due to human or force majeure factors.

The company only assume the legal obligation for the product itself, but don't
assume other responsibilities which caused by the using of the products.
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Il RDCAM V3.0 User Manual

Il Chapter 1 Overview

I.1.1 Laser engraving cutting system introduction
Laser engraving cutting system achieves effective control through a computer numerical,
according to the user’s different requirements of the completion of processing tasks. The
system including control board and control panel, and supporting software. This manual
describes how to use the software to complete the task of laser processing. (Motherboard
wiring and control panel operations see the accompanying manual and control panel wiring

board operating instructions)

I1.1.2 Software supported file formats
Vector format: dxf, ai, plt, dst, dsb...etc.
Bitmap format: bmp,jpg,gif,png,mng...etc.

II.1.3 Environmental requirements
(1) Windows 2K/XP/Vista. win7,XP recommended.
(2) Above CPU586, above PIIl or PV recommended.
(3) Memory, above 1G recommended.
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Il Chapter 2 Software installation

1l.2.1 Install steps
(1)  Double-click the Setup.exe under the installation directory, the following dialog box appears:

Welcom to use{®C1H4# H )

Install Driwer/IEz=hidE

Type/2iEil |C-:urel]]raw_Laser ﬂ

Lamuage/ 1B S ; |Engli5h ﬂ

[ Locate install path/TE{IEHERE

Install/%E | ExitfiBi |

(2)  Click [Install Driver/3¢z)%%%] to install USB drive:
If there are hardware installation prompts, choose continue until the installation is complete.

Hardware Installation

' E The zoftware vou are installing for thiz hardweare:
L

USE Serial Corveerter

has not pazzed Windows Logo testing to verify its cormpatibility
with Wwindowes =P, [Tell me why thig testing 1z important. |

Continuing your installation of this software may impair
or destabihize the correct operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
pazsed Windows Logo testing.

Continue Anpway ] EéTDPInstallatinn |

After installation, the following dialog box appears, indicating the successful installation of
USB drivers.

RLaserSetllp E]

L3
\!:) FTDI drivers have been install successfully installed!
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(3) Select the software version of the type and language, as shown below:

Install Driver/SEzhSEdE

HEF -
Type/SREL:  [Lasertork il\\; Select install language

Lamuage/ B 5 |Eng1i =h

[ Locate install path/TE{rE$ERRE

Exit/fiEH |

(4)  Click [install/Z%%] .After installation, following dialog box appears, indicating the software has
been installed successfully.

RLaserSetlip E|

\1;) Install Finish!
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Il Chapter 3 Software Basic Operation

11.3.1 The main interface operation
After start the software, you can see the interface shown in the following figure.

Menu Bar System Bar Cutting Property Bar

File® Rdit® DraD Cobfig® Handle®) Vier() HelpGh)
DE AE e CREARAQ|[» T e w2~ wmw

B T T T T . T T T T T R R 0D Blx|
— Device
NI
) Find Con | |hute -
. | Layer Faraneter
=
% 18- Layer = Mode Speed | Power  Output
or
L]
Al-
3 I :
= Edit Bar
*® E < >
K Control Panel < 5| [
=3 Laser work
EI:EL’ Position: |Current pesitio|w
= 3 Go seale Cut scale
B8 |-
E‘l @_: Start PauzefContinue Stop
E SaweTollFile VFileOutput  Download,
I [Joutput select graphics
- [FPath sptinize
=R
] Current Position | |X=7
E 1=
3 =7
£ Frevious work time | |ON:OM:03:0MS
=
2 hxis Move
E . Offset (un): |10
E Align Bar Layer Bar e
Jg\{ ‘ Y X I+ Power (#): |0
3 - 7- | [IMove from origin
[1f Light
=
T
Eowxgn@~r=0 NN HE EETE )]
—— #felcome to use the Laser system of cutting Propose the display area 10244768 or higher *— ¥:699. 123mn, ¥:578. TTTum

Menu Bar: The main function of this software is available through the implementation of the Menu
Bar. Menu bar including: Document, Edit, Draw, Setting, Processing, View and Help.

System Bar: On the System Bar, placed some most commonly command buttons which is chosen
from the menu.

Edit Bar: The Edit Bar default on the left of the work area. In the Edit Bar placed frequently used tools
to make the operation more flexible and convenient.

Align Bar: Alignment of the selected objects.

Layer Bar: Change the layer of the selected objects.

Control Panel: Using the Control Panel to complete laser processing of multiple tasks,
Layer parameter settings, axis control, processing etc.
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I1.3.2 Language settings and machine information
In addition to installation process can set the software language type, you can easily switch in
different language.
Click Menu Bar [Help] -> [#&5/Language] expand menu, select the required language types.

Help (H)
About EDCAM

| 18S Language

To obtain manufacturers information, so that we can provide you with better service. Click Menu Bar
[Help] -> [About RDCAM]

About rs_(|

Corp. Hame: |

Tel:|

fddr: |

|
|
Fa.x:| |
|
|

'|'|'e1:-:|

0K

11.3.3 page setting
Click Menu Bar [Config] -> [ Page setting] the following dialog box appears:

Page setting [5_<|

Fage widthimm]:

Fage height (mm): 800

Fage home Top left | =

cancat

[Page width] : Software page width, usually associated with machine X breadth.
[Page height] : Software page height, usually associated with machine Y breadth.
[Page home] : Software page zero point, usually associated with machine home position.
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File(F) Edit () Draw (D) Config(3) Handle(H) View (V) Help (H)
D HdH e S@QAR G|+~ " &0~ o[l Cut 10

(B [ T . P T T T I T T . TR AR oix|
1= Device
B Find Con | [auto -
= Layer Farameter
o = Layer = Mode Speed | Power  [Output
o
L] i .
al Top right
=
o5 Top left
*| 1 < >
5 Ip Town
Lazer work
A - Position: |Current pesitio|w
g - Go seale Cut scale
B8|.°
i Ej Start Pauze/Continue Step
E SaveTolFile VFilelutput |Downlead
i [Joutput seleat graphics
- [“]Path optimize
] Current Position ||X=7
=- Previous werk time ||
N L
] . hzis Move
E Bottom left Bottom right Desat ) 10
- 1 = | Speednfs): 50
H
=i *- x Power (8): |0
3 - z- | [JMove from origin
4 [J1f Light
=]
S
EAdwmwee@~r=lEANE NTHEHE EEYE
-— #felcome to use the Laser system of cutting Propose the display area 1DZA¥TES or higher #-—— X:7T50. 34Tmm, ¥ :334. 26Tmm

1.3.4 File open and save
The software uses rld file format to save graphic information. layer parameters of various layers and
processing sequence of the graphic elements.
1.3.4.1 Open File
(1) Click menu [File] -> [Open] ,or click iconi®, the following dialog box appears:

i,DlMy Documenks
-j My Compuker

'-3 My MNetwork Places

[CIRDCAMSELUp ¥3.0.2

I SendCormmand

ket Select file

File narne: | Default.rid Open

Filez af type: | *1ld w | [ Cancel ]

[ ] Open as read-only

(2) Select file (e.g. Default.rld), click [Open]
1.3.4.2 Save File

(1) Click menu [File] -> [Save] ,or click iconn,the following dialog box appears:
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Open... @@

Look in: | [E} Desktop * O 0 FF

L_4My Documents Default,rld
_& My Cormpuker

& My Nebwork Places

CIRDCAMSetUp V3.0,

) 5endCormmand Input file name

i [ A

File name: Crefadlt.rid

Files of type: | *1ld w Cancel

[ ] Open az read-only

(2) Enter the file name in the edit box, then click [ Save] .
11.3.5 File import and export
Supported file format for import: dxf, ai, plt, dst, dsb...etc
Supported file format for export plt
11.3.5.1 File import

&

Click menu [File] -> [Import] , or click icon . The following dialog box appears.

Select file, and click [Open] .

Laak jn: 3 PLT - J & % E-

I noooozz. ple R, e o #8457
4L plt @,
I S &Lk i 5472 plt
O 0%, ot 8 ot
o 7. ple
U A R I i
L. ple
U TR plt
IR 2, pit
O By SR it
oo and Curve,plt @Kﬁ.plt
U L e
R Bl 22323l
TR 585 2. plt
T 588, plt
O A RS o
UE A p
O - 2. e
T | .
I (443 plt
U7 Rzl dE sk S ol

Preview

File hame: Airplane. plt
Files of type: Supported Files1 A

Select [Preview] , the selected file can be shown.
For most vector file, data automatically imported into the corresponding layer of RDCAM software
according to the layer description.

For some special documents such as DST/DSB, data will be imported into the current layer.
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Import E| FE

Look jn: |‘.":)DST v| Qo

L5045-,D5T
L5066.D5T
Lx215.05T
MIS0.DET
PORSCHEZ.DST
SUNFLOWR . DST
VYEROMIKA.DST

Freview

Fiepame: | Ahudiel DST | [ gpen [-]

Files of bype: ‘ Supported Files1 R | [ Cancel ]

i Current layer

11.3.5.2 File export

Click menu [File] -> [ Export] or click icon LA . The Export dialog box appears.

Input file name, and click button [Save] .
11.3.5.3 File parameters setting
PLT Precision: According to the accuracy of the original plt file to select the appropriate import unit.
Smooth curves: When import vector file, automatically smoothing the original curves. For the
original graphic is smooth or need to repeatedly adjust the beset smoothing effect, you can uncheck
this button. Do not do smoothing curves may reduce time of import processing.
Auto close curves: According to close tolerance automatic check and closed curve
Auto delete repeat lines: Automatically remove the completely overlapped curves.
Combine lines: According to merger tolerance, auto-connecting curves.
Export precision: The accuracy of export plt file or output file.
Velocity unit: Software supported two types of speed unit: mm/s. m/min.
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File Parameter §|

Import Setting

FLT Precision: -

DSmnnth curwves

ﬁ;utu:- delete repeat lines
C-:-mbine lines

Export Setting:

Export Precision(%): éll:":'

Velocity Unit: |3/ Hinf=| -

conct

11.3.6 Basic graphics creation
¢ Line

Click menu [Draw] -> [Line] , or click Edit Bar 4 ,drag the mouse on the screen you can draw
an arbitrary line. Press the “Ctrl” key while dragging the mouse to draw horizontal or vertical line.
4 Polyline

e

Click menu [Draw ]-> [Polyline], or click Edit Bar . Drag the mouse on the screen you can draw
an arbitrary polyline.
4 Rectangle

O

Click menu [Draw] -> [Rectangle] , or click Edit Bar . Drag the mouse on the screen you can

draw an arbitrary size rectangle.
Press the “Ctrl” key while dragging the mouse to draw square.
¢ Ellipse

Click menu [Draw]-> [Ellipse], or click Edit Bar i . Drag the mouse on the screen you can draw
an arbitrary size ellipse.
Press the “Ctrl” key while dragging the mouse to draw round.
& Text
Click menu [Draw] -> [Text] , or click Edit Bar A :
Software supported two type of font to create text: TrueType and SHX.

@TrueT}’pe Font: |[ﬂ? it EF'jU—EalZ R"
S et e A0 ]l
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Double-click on the screen, the following dialog box appears.

Text g|

Text height (um): ﬂ

Text distance (mml; [0

Input text and text setting, click button [OK] .

11.3.7 Object selection
In the process of drawing and edit graphics, first of all is to select the object.
When the object is being selected, in the center of this object will have a shaped mark® x ”, and
surrounded by eight control points.

Click menu [Draw]-> [Select], or click Edit Bar [;i , switch to status “Select”. Under this status, you

can select object. The following are five kinds of method of selecting:
& Click menu [Edit] -> [Select All] (Shortcuts Ctrl+A) , select all objects.
€ Click mouse on the screen to select single object

'y
<
oLe.

€ Select object using select box

Press the mouse and drag, as long as the box come into contact with the object will be selected.
@ Increased select object/minus select object

Increase select: Press “Shift” key, click or box select to increase select object.

Minus select: Press “Shift” key, click or box selects the selected object.

@ Select object according to layer
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Lawer Farameter

Layer Maode  Speed Power Output

Cut 100,000 30,000 Tes
Cat  100.000 30000 Tes
Cut  100.000 30,000 Tes
Cut 100,000 350,000 Tes
Cut  100.000 30,000 Tes

p Dawn

Right-click the selected layer, then the part of all objects in the layer will be selected.
11.3.8 Object color
The color of object that is the color of the object contour. You can click the color button on the Layer
Bar to change the color of the object has been selected. The color of the pressed button is the color of
current layer.

11.3.9 Object transformation
Transformation of object mainly include: object location, orientation and size, but does not change the
basic shape of the object and its characteristics.
11.3.9.1 Object Image

Object image is flip the selected object in the horizontal or vertical direction.

Click Edit Bar A , flip the selected object horizontal.

Click Edit Bar ™, flip the selected object vertical.
1.3.9.2 Object Rotate

Click Edit Bar O ,» will pop up the dialog of rotate angel setting.
Set rotate angle and click the button [OK] .

Rotate angle (deg) ﬂ

corct

If you want to drag rotation, set rotate angle 0, and determine.

Dragging the mouse to adjust the rotate angle, in the dragging process, there will be followed by
rotating wire-frame outline.
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11.3.9.3 Object Size

Select objects, click Edit Bar i , will pop up the dialog of size setting.

Data S5ize E|
-

o |4EB.IEE | T |39.254 | ﬂ

canc

You can set size and center position of the selected object.

You can lock ratio of the selected object by checka.
11.3.9.4 Object Array Replication

oo
Click Edit Bar [:i , select object wants to copy. Then click @0, the following dialog box appears:

Hatrizx Copy

Piece size

= [s45.912 mm
[ |esz.07 mm

Matrixz Direction

@Top left OTop right

OBottom left OBottom right

Frame Widthimm): |1200
il

=

Frame Height (nm):
X ooam:
T rom:

¥ Distance (nm):

1

¥ Distance (nm):

D Distance between center

| Bestrewing breadth

Apply

D Center

0l Cancel

= Width of a single graphic (mm) I Height of a single graphic (mm)
You can array replication object along different directions. The direction of copy is based on the original
graphics. Such as choose the array direction lower right, and then the original graphic will appear on the
upper left corner wheras if it is to the upper left array, then the original graph appears in the lower right.
After setting the array number and array spacing, click button [ Apply] ,you can see the actual graphics
array.

There are two forms of array spacing: center spacing and edge spacing.

Choose center spacing, then [X Distance(mm)]. [Y Distance(mm)] representing the distance of
the two graphic center.

If not choose center spacing, then [X Distance(mm)]. [Y Distance(mm)lrepresenting the distance
of the graphic edge.
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Center distance X= Edge distance X + width of object

Center distance Y= Edge distance Y + height of object
Switch between the two kinds of calculate method, [X Distance(mm)]. [Y Distance(mm)] will be
calculated automatically.
Click [ Bestrewing breadth], The software will automatically calculate the array number
according to the workpiece size. width. height. X distance and Y distance.
Adjust spacing can be directly input values, and click [Apply]
Can also press the direction keys to adjust objects spacing.
Check [Center] ,then after object array replication, graphics will be centered on the work area.
Scroll the mouse wheel to zoom view of the graphics.
Drag the mouse to pan view of the graphics.

Hatriz Copy

Fiece zize
=345 912 mm

T |es2.07 mm
Matrixz Direction
, @Top left OTop right
‘O() OBottom left OBottom right

Frame Widthimn): |1200
Frame Height (nm): 800

¥ oram: |3
T orm: |3
% Distancefum): |7
¥ Distance(um): |7
I:‘Distance between center
Bestrewing breadth
Apply
I:‘Center
Ok Cancel

11.3.9.5 Place Object to the Origin
L+

Click [:g , select objects need to place to origin then click .
11.3.10 Object Align
O o E-'\ CQ [
Select objects, click tools on the Align Bar = =~ L H 4B H .
Whick include:

= |
= & 0 o Left alignment. Right alignment. Top alignment. Bottom alignment

nA L[
=Y = Vertical center alignment. Horizontal center alignment. center alignment

H 5 Horizontal equidistance. Vertical equidistance

= I = Same width, Same height. Same size.

Benchmark object:
If you press “Shift” key and select object one by one, Zhen the benchmark object is the last object.
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If you select object by select box, then the benchmark object is the object which curve number in the final.

11.3.11 Object View

*

+
Move: Click menu [Edit] -> [Movel, orclick *.Then hold down the left mouse button in the

drawing area, and drag pan.

Zoom Out: Click menu [Edit] -> [ZoomOut], or click *. Each click it, the drawing area zoom

out once. Move mouse to the drawing area and click, each click, mouse position as center
drawing area zoom out once.

Zoom In: Click menu [Edit] -> [ZoomIn], or click ~ Each click it, the drawing area zoom in

once. Move mouse to the drawing area and click, each click, mouse position as center drawing
area zoom in once .

View Select: Click menu [Edit] -> [View Select], or click = Move the mouse to the drawing

area, hold down the left mouse button and drag, a dash border box will show in the drawing area,
release mouse button, then the region in the dash border box will display in the drawing area with
the largest proportion.

View Page Frame: Click menu [Edit] -> [View Page Frame], or click B The page frame will
full display.
View Data Frame: Click menu [ Edit]-> [ View Data Frame], or click * The selected objects will full

display

11.3.12 Important Tool

Here are some frequently used tools. Using these important tools, can make the current

document in the graphics more orderly, and make the processing of output faster.

1.3.12.1 Manually Set the Cut Order

Users can set cut number of each object manually.

=
Click menu [Edit] -> [Show direction] and [Edit] -> [ Show path], or click System Bar . ,

—

I

—

Work area will display the path and direction of cutting.
Dash lines means that the laser is off.
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——— #Welcome to use the Laser system of cutting, Propose the display area 1024%TES or higher #-———

Graphics processing sequence is along the dash lines.

Cutting Property Bar shows the cutting serial number of the current selected object, modify the serial number,

cutting sequence will change also.

11.3.12.2 Manually Set the Cutting Direction and the Starting Point

=
Click menu [Edit] -> [ Show Direction] , or click System Bar , shows the cutting direction.

Click menu [Edit] -> [Show Point] , or click System Bar #® , shows all the points of the selected
graphics.

ot

Click menu [Edit] -> [Set Cut Point] or click System Bar , enter the mode for edit cutting point

As shown in following figure, the node where the arrow is located is a cutting point.
Double-click any point on the curve, will located the cutting point at the point.

S
Click menu [Edit] -> [ Set Cut Direction] or click System Bar =X , enter the mode of edit cutting

direction.
Double-click the node where the arrow is located, the cutting direction of the object will reverse.
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1.3.12.3 Setting and Editing the Cut In/Cut out Lines

Drawing or importing curves, the curve is default not having any cut in/cut out lines.
If want to add cut in/cut out lines, select the objects, then click [ Edit] -> [Edit cut in property] ,

or click - .The following dialog box is appear.

Cut in and out setting

Cut in

Enable

Cut out

Enable

Line type

Length (nm) : |

Angle (degree)

LineType

Length (mm) :

With angle
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To make cut in/cut out lines, first of all need to enable the cut-in/cut out function.

There are two types of the cut in/cut out lines: straight line and arc
Straight line cut in achieve through three ways:
a) Cut in with angle: cut in line and starting segment into a certain angle, counterclockwise
angle is positive
b) Cutin at center, the starting point of the cut in line is at center.
c) Cutin from center, the direction of the cutin line is from center to starting point, and length is
as setting.

Cut out line

o = -

Cut in line %

The arc length of cut in arc is as setting.
There are two types of cut in/cut out arc, as shown in the following figure

Female Male

The processing of setting cut out lines is same as cut in lines.

I.3.12.4 Path Optimization

Path optimization if primarily to re-order the vector graphics.

(=]
Click menu [Handle] -> [ Cut optimize] , or click ®“ ,the following dialog box is appears.

Inside to outside

Single inmer to outer -
Dﬁ.rra}'
Height: (50 Dir: |Up to bo|w

Conce
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[
Click menu Edit]-> Bhow Path], or click |H_I| can see the cutting path before and after processing.

Laser head

Before processing After processing

Graphics cutting path is always starting from the laser head.

1.3.12.5 Curve Smooth
For some less accuracy curves, this function can make curves more smoothness, and processing

smoother.

Click menu [Handle] -> [ Curve Smooth] , orclick ™, the following dialog box appears.

X]

Curves =mooth

Smoothness

[ .

FullFrame Cancel
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Drag the smooth slider, and click button [Apply ], before smooth and after smooth curves will all show in
the dialog.

Curvez smooth f5_<|

- s SR 0% R

FullFrame Cancel

The black curves represent the original curves, and the red curves represent after smooth curves.

You can view the graphics with drag mouse.

You can zoom in/zoom out the graphics with scroll wheel.

Click button [FullFrame] , graphics will shown in the dialog box for largest.

After get satisfied smoothing effect, click button [ Apply] , curves will processing smooth according to
smoothness settings.

11.3.12.6 Check Closure

Click menu [Handle] -> [Curve auto close] , or click System Bar [ ,the following dialog box appears.

Setting close error r5_<|

F-:-rce to close

corct

Close error: \When distance from the starting point to ending point less than close tolerance, automatic
closing of the curve.
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Force to close: Mandatory closure of all selected curves.

11.3.12.7 Remove the Overlap
Click menu Handle]-> Delete overlap],or click = , the software will automatically remove the ovlapped

curves within the selected curves.
There are two parts of the function of remove overlap:
Broken the curve into numbers of parts, when a single curve overlapping within itself.

Automatically checks the completely overlapped curves, and prompted to remove them.

Check ovelapping lines |g|

Cwvelapping lines exist,delete ar nok!

| ves | [ Mo ]

11.3.12.8 Combine Curve
b
Click menu [Handle] / [Combine Curve] , or click = ,the following dialog box appears.

Setting combine error ﬁ|

Combine error (mm):

concl

The software automatically merges curves in the selected curves, when these curves merge toleracnce is less
than the setting of combine error.

11.3.12.9 Bitmap Handle

Click L\\; , and select a bitmap, then click menu [Handle] -> [ Bitmap handle] , or click System

EMP
Bar .
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Pixels
Pixels

Pixels
Pixels

Pixelsfinch Pixelsfinch
Pizelsfinch Pizelsfinch
Brightnes:
: W
0. 0%
Contrast:
W
0. 0%

D Inwert color

Rezolution(pizelsfinch)

Resolution(pixels/inch)

[JDi ther
Het zraphic
Frequeney [Lines/inch]: I:I
Dot graphie
Black And %hite
Gray scale

070/ 201

Apply to wiew Apply to zource

i

Save as é;fFullScreené

Ok

Cancel

In the top right of the dialog box displays the information of the current image.
Be noted that, the horizontal resolution and vertical resolution is changing with drag scaling.
[ Apply to view] : Current settings is only used for preview, without affecting to the original bitmap,
press button [Cancel] , bitmap will returned to the state of original image.

Therefore, only use for adjust effect. However, this approach requires more time and memory space.

[Apply to source] : Current settings is use for original bitmap directly, so even finally click button
[Cancel] , image will also unable to return to the original image.
Therefore, it mainly used in multi-step operation, and the current operation of this
step is necessary to do, such as general pictures must be transformed into grayscale.
This can save the computing time of the follow-up operation.
[ Save as]: Retain the results of the previous operation, In addition to using [Apply to view]can also
be exported. On this basis, to facilitate subsequent processing.
[ Gray scale ]1Generally, other image processing'’s is based on the grayscale, so before handling, you
can do a grayscale processing, then click button [Apply to source] .For the grayscale than the color
image occupied smaller memory, for large image step by step handle, to a certain extent to avoid the
lack of memory.

For color image, adjust contrast and brightness, have some auxiliary effect to following dither processing.

Adjust contrast:
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[ TR

After processing
Invert:

Before processing After processing

There are three method for dither processing: Net graphic. Dot graphic. Black and white
1> Net graphic

Net graphic need adjust net size, better suited to material which is not high resolution, or the
laser is relatively slow to respond.

To get the appropriate net size, you can adjust resolution and net frequency of the image.

The higher resolution, the more delicate.

The higher net frequency, the smaller net size. The lower net frequency, the bigger net size.

Generally, resolution of image is 1000, and net frequency is 30-40lines.
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2> Dot graphic
Dot graphic performance of good grayscale, better suited to material which is high resolution, and
the laser responds fast.

AT
3> Black and white
In most cases, the effects of color image into black and white image is poor,, however, for some clear
outline image, is very easy to use.

e
'
'

Y ELFSEN
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ll Chapter 4 System Settings

Before output graphics, required to determine whether the system settings are correct. Click menu [Config]
—> [System Setting]
Config(3)| Handle(f)  Vie

Swstem Setting |

File Para Setting

Page Setting
Pazsword Setting

Graph Hatch

1.4.1 Laser Export

Settaing

Lazer export |Geperal settings | Machine para || Document | System Info
Scanning (Reversze interwal)

/El Feeding Count: Speedimmf=)  Rewerze ...

Enable feed Di=tance (mm) :

Line/colunn setup

X Hum: |1 T Hum: |1
Y¥=pace (mml: |0 Yepace (mml: |0

D Enable center distance

Bestrewing breadth. ..

£ >
DEnable rotate engrave
: Add. .. Del
Diameter (mm)
Step per rotatel(pulse): — [0 I 0

1> Feed Setting
To use the feed, must first enable the feed.
After set feeding parameters, the shaft will be feeding a feeding length, and repeat the process, until
the times of processing reach to number of feeding.
2> Array Setting
Array processing setting is facilitating used to treatment array processing of graphics.
X Num and Y Num, correspond to the rows and columns of the array
X Space and Y Space, correspond to the rows spacing and column spacing of the array.
If not check “ Enable center distance”, the X space and Y space means edge spacing, otherwise
means center spacing.
3> Bestrewing Breadth Setting:
According to the size of frame and current array settings, to determine the maximum number of
columns(X Num) and rows(Y Num).
Click button Bestrewing breadth, the following dialog box appears:
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Bestrewing breadth §|

¥ breadth(nm): 20

T braddth(em); |S00

conet

Click OK, software can automatically calculate the appropriate numbers of rows and columns.
4>Rotate Engraving

[ Enable rotate engrave] : After enable engraving, the actual precision of Y-axis will be based on
diameter and step per rotate to auto match the setting of pulse precision of Y-axis. In addition, the work

area in the main interface will also change.
[Diameter] : The diameter size of the parts.
[ Step per rotate] : The number of pulse corresponds to the workpiece rotate one week.
5>Reverse interval
While bi-directional scanning, for the tension of belt, may cause the edge of graphic irregularity. So
provide backlash setting to amendment it. A specific speed corresponding specific backlash.
Generally, the faster the speed, the greater the backlash.
(DAdd backlash setting
Click button Add, pop up the following dialog box

corct

After setting Spped and Reverse interval, then click OK, the backlash value be inserted into the
backlash list
@Modify backlash setting
Double click the item in the backlash list, pop up the following dialog box.

®Remove backlash setting
Click to select item which want to delete, then click button Delete.
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I.4.2 General Setting

Settaing

Laser export | @eneral settings Machine para | Document | System Info
bxis Mirroer Lazer head
‘sl 8] o Joint Frecizion(0-2mm):
FL Y
ﬁ.xis T Mirror @ e
Cutting space Repay
Emall circle =zpeed limit DEnable cut baclklash repay
| Radius (nm) Speed (nm/s) | i r L
| Repay: [0 0
Space (mm): |0 0
DCutting lazer on—off repay
| [ LazserOn  Laszer(0Off
( - Repay (nm): | (|
Add. .. Delete Energy (%) |

1>Axis Mirror
Generally, Axis direction of mirror is based on the actual location of the limit or home of machine.

The default coordinate system if Descartes coordinate system, and zero in the bottom left.
If the zero point of the machine is top left, Zhen X-Axis do not need to mirror, but Y-Axis need to

mirror.
If the zero point of the machine is top right, Zhen both X-Axis and Y-Axis are all need to mirror.

In addition, this function can also use to other application for mirror.
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2>Laser head

Position of Laser head means the location laser head relative to the graphic.

|
¥ v, 7
Qv 00 o0
Top Left Top Middlle Top Right
%2 W92 W
] a0 o a0
|
Middle Left Center Middle Right
08 W02 W
o 00 00
I
Bottom Left Bottom Middle Bottom Right

3>Joint precision (0-2mm)
When the distance between the end point of one line and the end point of another line is less than the
joint precision, the software automatically connect these two lines.
Note: 7%is value is usually set to 0.Immjfor very large amouts of data graphics,in order fo reduce the waiting
time before processing can be set to Omm.
4>Run Repay
For the jump motion moving faster,may occurs position error.Using run repay can compensation this.
5>Small Circle Speed Limit
On processing work, the software automatically determine whether the current round need to limit
speed ,then according to the diameter size of the circle to determine the speed.
If parameter configuration appropriate, will greatly enhance the quality of small round.
Click button [Add]. [Delete] to configuration.
The software can automatically calculate the speed of the round, according to the round speed limit list.
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6>Cutting laser on-off repay
[ Cutting laser on-off repay] :
After enable , the software auto compensation the cutting processing according to the cutting laser on-off
repay settings.
[Repay] : The processing of laser-on, laser energy from start energy for a gradual change to the
normal energy ,while the machine from the start point moves a laser-on repay length.
The processing of laser-off, the machine from the end point moves a laser-off repay length.
[Energy] : The energy of the start point of graphics.
I1.4.3 Machine Para

Settaing

Lazer export | General settings | Machine para |Dacument | Svstem Info

Bl Cut parameters | | [0 Axiz parameters ~
Idle =zpeedimmf=) 200,000 hxis X
Idle heeimmf=2) 3000, Qoo Direction polarity Hegatiwe
Start speed(mm/=s) 20,000 Limiter polarity  Hegatiwve
Min feeo (nmd=2) 400, 000 Contrl Mode Pul=etDir
Max hee (umd=2) 3000, oo Keying direction  Hegatiwe
Cutting mode Hormal Cutt Step length (um) 0. 350
Ao Mode 3 mode Max speednmfs) 1000, 000

[ Sweep parameters Jump—off =peedimm/ 5. 000
x¥ Start Speedimm/s 10.000 hecelerationimmds2 2000, 000
¥ Start Speedimm/s 10,000 “ Breadth (mm) 1000, 000 w

Open Eead

(1) Machine parameters are described as follows:

A. Laser parameters

a. Laser mode: there are currently three types of Laser devices: home-made glass tube, RF Laser
(pre-ignition pulse not required) and RF Laser (pre-ignition pulse required), the glass tubes adopt
analog quantity for control and RF tubes adopt digital quantity for control. If the machine adopts
home-made glass tube, the laser type should be “Analog quantity”, while if it adopts RF tube, the
duty ratio (pre-ignition pulse required/ not required) should be selected correspondingly. After
modification of Laser type options, the system should be reset, and the modifications should take
effect after the reset.

b. Laser freq. the pulse frequency of the control signal used by the laser installed on the machine.

c. Max. power (%), Min. power (%). you can set the limit power values for the laser, namely, during
the operation, the max. power set by the user cannot be higher that the max. power set here and
the min. power set by the user cannot be lower than the min. power set here.

d. On-delay, off-delay. if the on/off delay parameter is not 0, when the laser is turned on/off, the laser
will be turned on in advance and turned off behind schedule at the time delay set in advance. The
range for the time delay may be Ous ~ 0.1s.

B. Other parameters

a. reset speed this parameter decides the speed of the machine to return to the origin when startup,
if the breadth of the machine is too large, you can set a comparatively large value of reset speed,
but do not set it too large, the controller will control this parameter within 50mm/s, namely, any
reset speed value set by the user exceeding 50mm/s should be deeded invalid.

54



User’s Manual of Laser Engraving / Cutting machine http://en.shenhuilaser.com/

ldle speed: this parameter decides the max. speed of all lines not emitting beams during the
operation of the machine. This parameter should not be lower than the lower of the jump-off speed
of the X-axis and that of the Y-axis and not exceed the higher of the max. speed of the X-axis and
that of the Y-axis, if the setting is illegal, the controller will automatically set this parameter within
the range above; a comparatively high idling speed can shorten the operation time of the entire
figure while excessively high idling speed may cause dithering of the tracks, therefore, you should
take all relevant factors into consideration when setting.

Line shift speed of scanning. this parameter is specially used to control the max. speed of the
scanning to shift vertically from one line to the next line below it. If during the scanning, the line
space is too large or the block space is too large when scanning block figures while precise
positioning for each line or block is required, you can set the line shirt speed of scanning to a
comparatively low value. This parameter cannot be less than the jump-off speed of the
corresponding axis during the line shift and cannot be higher than the max. speed of the
corresponding axis during the line shift, if the setting is illegal, the controller will automatically set
this parameter within the range above.

Acce. mode: this parameter decides the acceleration and deceleration mode (S mode or T mode)
of the motor during operation, the motor accelerates and decelerates slowly and smoothly in the S
mode and fast and relatively unsmooth in the T mode; the default mode is the S mode.

Scan mode: There are two modes for your selection: the general mode and the special mode, in
the general mode, there’s no any treatment during the scan, in the special mode, light spots will
be treated. If the special mode is activated, the power of the laser should be increased and
correspondingly, the light spot percentage will be lower and the laser power attenuation will be
higher, to achieve the same depth of scanning, the laser power should be higher. The purpose to
select the special mode is to make the laser to emit beams at high power and in short period,
during deep scanning, the effect of flat bottom can be
achieved, however, if the light spots are improperly adjusted, this effect may not be
achieved and the working mode of high power and short period may influence the service life of
the laser. The default mode is the general mode.

Facula size. this parameter is invalid in the general mode of scanning and is only valid in the
special mode. The controller will control this parameter at 50%~99%.

Array mode: you can choose the swing mode and the one-way mode. The Swing mode: cutting
the array back and forth in order; the One-way mode: always cutting the array from one direction
to another. If One-way mode is selected, all array units have the same movement modes and the
same liquidity of movements; however, this mode will take more time than the swing mode. The
default mode is the Swing mode.

Return positiorr. You can select the locating point and the machine origin. This parameter decides
the position, the locating point or the machine origin, where the laser head stops upon completion
of each operation.

If Protection orr. If the machine is provided with any additional protection signals besides water
protection, you should make corresponding selections in this option. The protection signal is
inputted from universal input port 2 port (please refer to the User's Manual of the main board).
When this protection signal is enabled, the controller will carry out real-time inspection on the
protection signal, if the input is at high level, the machine will be protected and the operation in
progress will be suspended and the laser will be turned off.

C. Axis parameters

a.

Direction polarify. if a the X or Y axis move against the machine origin when the electrical system
of the machine is reset, that means that the direction signal polarity of this axis is incorrect, at this
time, you should disconnect the axis from the motor driver (otherwise, the inspection of the main
board will be insufficient, which may cause collision of this axis), after D16 on the main board
flashes (which means that the reset has been completed, D16 will go out first each time the
machine is reset and start flashing after reset completion, do not read or write all parameters on
the PC before D16 starts flashing, please refer to the User’'s Manual of the main board interface
for the position of D16), modify the direction signal polarity of this axis on the PC, upon completion,
press the Reset button to reset the main board.

Limiter polarify. If when the axis of movement reaches the limit position, a low level signal is
triggered to turn on the LEDs corresponding to various limit positions and when the axis of
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movement departs from the limit position, a high level signal is triggered to turn out the LEDs
corresponding to various limit positions, the limit polarity is negative; contrariwise, if when the axis
of movement departs from the limit position, the LEDs corresponding to various limit positions are
out and when the axis of movement reaches the limit position, the LEDs corresponding to various
limit positions are on, the limit polarity is positive. Incorrect limit polarity setting may cause
insufficient inspection of the system when resetting, which may lead to collision of the axes.
Contro/ mode: There are two modes for your selection: the double-pulse mode and the pulse +
direction mode, which should be deiced according to the type of the motor drive installed on the
machine, in general, the pulse + direction mode is selected. After any modification of the control
mode option, the main board should be reset to make the modification take effect.

Keying direction: After correct setting of the direction polarity of the machine, if the X-axis moves
to the Right when you press the Left button and the X-axis moves to the Left when you press the
Right button, that means the keying direction settings are incorrect and modifications should be
made correspondingly; the Up and Down keys are corresponding to the movement of the Y-axis, if
the Y-axis moves upwards when you press the Down button and the Y-axis moves downwards
when you press the Up button, the keying directions of the Y-axis should be modified.

Step /ength. Or the pulse equivalent of the motor, it means the absolute distance covered by the
corresponding axis when a pulse is sent to the motor. Before correct setting of this value, you can
make the machine to cut a large rectangle (the larger figure, the less error) and the motor pace
length can be calculated automatically with the length of the figure and the measured length.

Max. speed” The driving force of the motor and the inertia of the axis of movement decides the
max. speed of polarity of the axis. During the scan, the scanning speed should not exceed the
max. speed corresponding to the axis of the scanning; in the cutting mode, the resultant velocity
during the cutting cannot exceed the lower of the max. speed of the X-axis and that of the Y-axis.
If the speed is set too high, the controller will automatically protect the speed under the max.
speed.

Jump-off speed: the speed of the axis of movement to be started directly from the static status, if it
is set too large, the motor may lose synchronism, dither or even produce whistle, if it is set too low,
the operation speed of the entire figure will be reduced. According to the inertia of the axis of
movement, this value can normally be set at 8~15mm/s. If the inertia of the axis of movement is
too high (the axis is heavy), you can set a lower jump-off speed, while if the inertia of the axis of
movement is too low (the axis is light), you can set a higher jump-off speed.

Acceleratiorr. The acceleration of the axis of movement when accelerating or decelerating, too
high acceleration will also result in loss of synchronism, dithering or even whistle of the motor,
while too low acceleration will result in slow acceleration which will reduce the operation speed of
the entire figure. A typical range of 800 ~ 3000mm/s2 can be set for an axis with high inertia,
Y-axis corresponding to the crossbeam, for instance, and a typical range of 10000 ~ 20000mm/s2
can be set for an axis with low inertia, X-axis corresponding to the dolly, for instance.

Breadth. the max. distance that the axis of movement can cover, which should be decided
according to the actual situation of the machine.
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I1.4.4 Document

Setting

Lazer export | General settings | Machine para | Document |Sectem Infa

Document

Humber File Hame

Document list

Deleate Delate A1l

Read Download Frocess
1> Read
Click button Read, the software will communications with the controller, read the list of files on the
controller.

After read controller successful file information will be displayed in the document list.
2> Download
Click button Download, will pop up the file dialog , select *.rd downloaded file, then the file will be
downloaded to the controller.
If the download is successful, the document list will update.
3> Process
Select the file to be processed from the document list ,and click button Process
The controller will start the specified document.
4> Delete
Select the file you want to delete from the document list, and click button Delete
The controller will delete the specified document.
If the deletion is successful, the document list will be updated.
5> Delete All

Automatically remove all file in the controller, and update the document list.
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11.4.5 System info
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Setting

Lazer export | General settings | Machine para || Document

Total on time (hour min:s):

Total processing time Chowr min:s):
Frewious processing time Chour min:s:ms):
Tatal laser on time (hour min:s):

Total processing times:

X Total trawal (m):

T Total trawel (m):

Mainboard wersion:

System Info

Total on time: The total time of motherboard working

Total processing time: The total time of processing, including the time of jump moving.

Previous processing time: The time of the last processing
Total laser on time: The time of the laser processing

Total processing times: The number of completed processing, not include the processing forcing to

end.

X total travel: The total travel of motor X.

Y total travel: The total travel of motor Y.

Motherboard version: The version of the current controller.

11.4.6 Password Setting
Config [E)| Handl e () Viey

Swpstem Setting
File Fara Setting

Page Setting

Fassword Setting

Graph Hatch

The manufactory can use the function of password setting to set manufacture password or user’s

period password.

Click Password Setting, if has connected with the controller , pop up the following dialog.
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Input ¥endor Password §|

Vendor Password:

U

| [ Cancel ]

After input the correct manufactory password, pop up the following dialog.

Fazzword zetting E|

I Vendor Password l

I Feriod Fazsword l

1> Vendor Password Setting

¥Yendor Password S5etting §|

|

01d Fas=zword: |

1. Input old password

|

2. Input new password

Hew Fassword: i

Confirm |

—]
L 1
3. Confirm new password

4. Modify password

As figure shown, input the Old Password. New Password and Confirm Password , then click

Modify.
LaserWork E|
! E Password modified success!
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2> Period Password

Period Password 5etting [5_<
Ly 1. Number s of Period

Humber of Periods

ly.| 2. Input Vendor Password

Yendor Fassword: ok

i

Period irdler ol 3. Input Period Interval

!n._.

[variable Feriod T »| 4. Set Variable Period

| Cencel | [Save Pasmword] ”| 5. Save Password

After setting Period. the number of day each period and vendor Password.

Click Save Password, then pop up the file dialog to save the password file.
Save as... @

Save jn: | [} Desktop v| D & EF E-

SMy Documents

j My Computer

‘-3 My Metwork Places
(JJRDCAMSetUp ¥3.0.2
(=3 SendCommand
L)tk

% debugcommand. bxt

| [ sae ]

File name:

Cancel ]

Save as bupe: |“_txt "| [

After save password successful, pop up the prompt dialog.

LaserWork E|

' E Create Passward Success!
L
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Information of the password file.

[ password.txt - Notepad EJE”EI

First Period File Edit Format Yiew Help

Password of Period 1 ) The number of day of Period 1

Password for Cancel

If the software be locked, you can input the corresponding password for the current period,
or input the password for cancel.
After input the password for cancel, then the controller will no longer limit.
3> Variable Period
If you need setting variable day for each period, can check Variable Period.

Period Password Settaing &|

Humber of Feriods 2

Yendor Fazsword:

Period Interwal:

[#] ¥ariable Fericd

[ Cancel ] [Save Paz=zword

Check Variable Period, and click Setting
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Period day setting [$_(|
Period HO Feriod Inte. ..
1 1
o [2
< >

After setting successfully, quit this dialog, and save password
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Il Chapter 5 Processing

Device

/ Find Com huto -

Layer Farameter

Search device

Layer Mode Speed Fower (utput

PR E—

Layer settings

g Dawn

Lazer work

Fosition: Cuwrrent positio| -

o scale Cut scale
Start Fansze/Continme Stop
<& SavaTallEsl UF1lelutput TDownload

Processing control

Dﬂutput select gzraphics
Path optimize

Current Fosition

=0 ) =D

e
T
Z

Frewions work time | |OH:0M:05:0MS

Axiz Mowe
Offzet (um); (10
: —— It T+ i
Axis control Speed (mmf=): |50
- I+ Fower (%1 |0
¥ 7 DMD‘:-"E from origin

[]If Light

1.5.1 Search Device
If the computer only connected one device, you can set to Auto. The software will automatically
search the device.
If the computer connected many devices, then first of all you need to click [Find com] .
After search, the connected devices will all add to the drop-down list.
What you need to do is select the specified device.
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I.5.2 Layer settings

0l

I= Output:
Speedimmf=):
Min Fower (31: |30
Maxe Pewer (%): |30
If Blowing: Tesg
Processing Mode: Cut
Seal [0-5mm):

Open Delay(nz):

Close Delay(ms):

1]

1]

1]

Cancel

http://en.shenhuilaser.com/

There are two options: Yes and Mo. Select Yes, ths
corresponding layer will be exported for processing; Selec

The speed of laser processing; speed will influence the
processing effect: the slower the speed is, the better the
processing effect is and the smoother the track is; the
faster the speed is, the worse the processing effect is; if

The range of power value is 0~100, it means the intensity
of laser during the process; the higher the value is, the
stronger the laser is, and the lower the value is, the weaker

Processing mode, meaning the mode to process
corresponding layer; If you select vector layer (color layer)
currently, there are three options: Laser scanning, Laser
cutting and Laser dotting; If you select bitmap layer (BMP
layer) currently, there is only one option: Laser scanning.

(1) How to set proper Min power and Max power

If the laser is too strong during the whole process, you should set the minimum and maximal
power lower, otherwise, set them higher;

If the laser is too weak in some places during the process, you should set the maximal

power higher;

If the laser is too strong in some places during the process, you should set the minimum

power lower.

(2) Setup of processing parameters under different Processing modes
Processing modes include Laser scan, Laser cut and Laser dot. The bitmap layer (BMP
layer) can be only processed by Laser scan.
(D Setup of processing parameters in the Laser scan mode
As shown in the following figure, if you select processing mode of Laser scan, the menu
is as shown in the following figure.
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...............................

Ramp Length (mm):

http://en.shenhuilaser.com/

DRamp Effect

I= Output: |Yes - . Iz Output: |Tes -
Speed(mmfg): [100 Speedimmf=); 100
Min Power (%): |30 Min Fower (%1: |30
Maze Power (%1: |30 Maxe Power (%1: |30
If Blowing: Yes - If Blowing: Tes -
Processing Mode: Sean - Frocesszing Mode: Sean -
[Hegative 1 [“Iptimized:

Ramp Length (mm):

Owerstriking: |[Un-—process - Owerstriling:
Sean Mode: X _swing - Secan Mode: (¥_swing -
Interwal (mm): |91 Interval (nm): |91
Offsetd (nm): U Offsety (nm): U Offsety (nm): U Offsety (um): O
Advace Advace
Ok Cancel Ok Cancel

The Vector layer (color layer) doesn’t support Negative engraving and Optimized scar.
Negative engraving.’ If you do not select Megative engraving, the black dots which run across the bitmap will emit
laser and the white dots which run across the bitmap will not. If you select Negative engraving, the white dots
which run across the bitmap will emit laser and the black dots which run across the bitmap will not.
Optimized scan. If you select Optimized scan, it will adjust users’ setup of Scanning inferva/ automatically
to the best values and optimize the scanning effect. Otherwise, we should select Scarnning inferval as set
by the user for scanning. We generally select the Optimized scanning.

Ramp effect. If you select Ramp effect, it can make the track edges of scanned figures presented as
ramp in order to attain solid effect.
The Minimum power set currently corresponds with the power of the top ramp, the
Maximum power corresponds with the power of the bottom ramp. You should set the
same value for the maximum power and the minimum power if you do not select ramp
effect.
Ramp length. the length of the ramp

Overstriking. \ncludes Un-process, /ntaglio and Rilievi
No processing. does not adopt overstriking.
Intaglio. when selecting the intaglio font (please refer to the attachment below for what is font intaglio), the font will
receive overstriking processing.

Note: if you select Ri/jevifor Overstriking when selecting intaglio font, the font strokes will
be thinner instead of thicker.

R/levi: when selecting rilievi font (please refer to below attachment for what is font rilievi), the font will
receive overstriking processing.
Note: if you select Intaglio for Overstriking when rilievi font, the font strokes will be
thinner instead of thicker.
Additional note: What are font intaglio and rilievi?

Font intaglio: the text does not have the outline border. It is the text itself that is to be scanned, please

Welcome

see the figure below:
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Font rilievi: The text has the outline border, it is the figural base to be scanned, please see the figure

Welcome

Scan modes. including X _unilateralism, X_swing, Y _unilateralismand Y _swing.
X unilateralism. The laser head scans figures back and forth at the level direction, but only emit laser

below:

toward one direction. For example, the laser head emits laser when scanning from right to left, but not
emits laser when scanning from left to right.
X _swing.: The laser head emits laser and scans figures back and forth horizontally.

Y unilateralism. The laser head scans figures back and forth vertically, but only emit laser toward one
direction. For example, the laser head emits laser when scanning from the top down, but not
emits laser when scanning from the bottom up.

Y swing.: The laser head emits laser and scans figures back and forth vertically.

Note: We generally adopt the scanning mode of X_swing.

Interval: The interval between the current line and the next line to be scanned by the laser head. The
smaller the interval is, the darker the scanned figures is; if reverse, the weaker.

Recommendation: @ the scanning interval is set below 0.1mm for vector layer (color

layer) in general. @ the scanning interval is set above 0.1mm for bitmap layer (BMP

layer) in general, and then the Minimum power and Maximum power should be
changed to attain the perfect effect of the scanned figures.
@ Setup of processing parameters of Laser cut

The processing mode is Laser cut as shown in figure

Seal (mm). it means the length of the extended line at the closed figure interface. We set it at zero in
general; If the value is set above zero (0-2mm), it is usually used in the craft of cutting polymath
methacrylate to eliminate the obvious heave effect.
® Setup of processing parameters of Laser dot

Laser dot: drawing dots along the track of the figures.

As shown in figure, select Laser dof as the processing mode, the menu will be showed as figure
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Lavyer Parameter

Iz Output: Tes - .

Speed (nmfg);  [100
Min Fower (%): |30

Max Power (%): 30

If Blowinz' |Tes i The time for emitting laser on
B Dot v one dot during the process. The

/ higher the value is, the darker
Dot timels): I

L —_—"| The interval between the dots
ot 1nterw m)

Dot length(mm): |0 \ I

Dot length, for cutting dash line

Only dot at center

Ok Cancel

Layer reorder:
Click button ¥P, Down can change the order of layers, the above layer processing first.
11.5.3 Position
Setting the laser head back location after processing completed.(Current position. Original anchor.
Machine Zero.
Current Position: Laser head back to the position before processing.
Original anchor: Laser head back to the last anchor, the anchor may set at panel.
Machine zero: Laser head back to the zero of the machine.
11.5.4 Go Scale, Cu t Scale
For Example Go Scale, as the following figure shown, the actual graphic is round, and the red
rectangle outside the circle is the smallest rectangle, click button Go Scale, laser head will run once along
the rectangular path.

/

For Example Cut Scale, As the following figure shown, the actual graphic is round, and the red
rectangle outside the circle is the smallest rectangle, click button Cut Scale, laser head will be cut along
the rectangle.

1.5.5 Start, pause, stop, saveToUFile, UFileoutput, Download
Start: Output the current graphic to the machine for processing.
Pause\Continue: Click Pause, will stop the processing work, click the button again to Continue
Stop: Stop the current processing work
SaveToUFile:
Save current file as RD format, using for offline processing (Can be copied to other memory board for full
offline operation) .
For example: Save the round

67



6 User’s Manual of Laser Engraving / Cutting machine http://en.shenhuilaser.com/

Save as... @@
. |E| Save in: | (B Desktop - O s [0

[i4ry Documents

_é [y Computer
My Network Places
[C)RDCAMSEtUp ¥3.0.2

|1 SendCommand
[T ekt
m bar.rd
[ ] n
File: namne:

Save asz type: | *rd w

UFileOutput:
Output the offline file (RD format)
After save offline file, click UfileOutput to select rd file to processing.
Download:
Download the file to the memory of the controller , then user can start the file through the machine panel.
11.5.6 Output select graphics
After check Output select graphics, then only output the selected part, rather than not output the
part not selected
1.5.7 Path optimize
After check Path Optimize, then automatically perform the path optimize before the output.
If has done the Path optimize or not need optimize, then not check Path Optimize can reduce waiting
time.
11.5.8 Axis move
Axis control can only control one axis each time.
You can set the information for axis move, including move length . speed. laser on-off and laser
power.
If you check move from origin, then the offset you set means the offset to machine zero.
If you not check move from origin, then the offset means the offset to the current position.
Note: According to the provisions of the controller, the absolute position is no negative in the
whole breadth. If you check the Move from Origin, and set the offset value negative, then the
machine will hit limiter.
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Il Chapter 6 FAQ

11.6.1 After start processing, the machine does not move or disorder or loss part of
graphics
€ Check whether the graphic data is out if frame. The data beyond of the frame will not be
cut.
€ Check the setting of Laser head position.
11.6.2 Software automatically shut down when import file
If the operating system is XP, please check if the patch is installed.
11.6.3 Machine panel prompt [Less buffer distance]
€ Check the engraving speed in the machine parameter, generally, the engrave speed
no 8000
€ Ensure that graphics are not close to the border of the machine frame.
11.6.4 Processing graphics sis mirror to the actual graphics
Check “Axis Mirror” in the General settings dialog (See: 4.2 General settings >
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lll User’s Manual of Laser Engraving

Cutting Software v3.0
Preface

There are two kinds of laser engraving cutting software. One is based on the direct
output software of CorelDraw (hereinafter referred to as CorelDraw Laser); the other is
based on the direct output software of AutoCAD (hereinafter referred to as AutoCAD Laser).
Now we are going to introduce them in turn:

lll. Chapter 1 Introduction of CorelDraw_Laser

lll.1.1Features of CorelDraw_Laser
Mainly used in movement control, it is an important part of laser movement control and is. It
realizes effective control to laser numerical control machine tool by computer and accomplishes
processing tasks according to user’s different requests. There are its functions and features
below:
1. CorelDraw_Laser is a plug-in module stalled in CorelDraw, utilizing indirectly powerful functions
of plotting and edit such as zooming and circumrotating.
2. It supports almost all the file formats supported by CorelDraw, including vector formats (such as
PIt and Al) and bitmap formats (such as BMP).
3. It is able to support the file formats of DST and DSB (not supported by CorelDraw itself) by the
import function of CorelDraw_Laser module itself.
4. It supports the function of files synthesizing by utilizing the import function of CorelDraw, allowing
many files to be exported and processed once and for all.
li.1.2 Environmental requirements
1.Above CPU586, above Plll or PIV recommended
2.Memory, above 1G recommended
3.Windows2000/XP. Vista. WINI, XP recommended
4.Support the software of CoreDraw11 and CorelDraw12. CorelDraw13. CorelDraw14.
lll.1.3 Installation and startup
lil.1.3.1 Installation
1.You should have installed CoreDraw11 or CorelDraw12 before you install CorelDraw_Laser.
If you don't, please install CoreDraw11 or CorelDraw12 on your computer first.

2.0pen CoreDraw11 or CorelDraw12. CoreDraw13. CoreDraw14, complete the configuration
before installation.
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4 D_: Object Data Manager @
é@‘ 7 View Manager Ctrl1+FZ2
] Linle Manager

Unda Docker

=8 Internet Boolmark Manager

Color Styles
Falette Editor. ..
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= Graphic and Text Styles  Ctrl+FS =
' Scrapbook 3
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2
£
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Figure 1-1

(1) As shown in figure 1-1, enter the main menu of CorelDraw, choose CorelDraw menu,
tools->options, a menu as shown in figure 1-2 will pop up:

| XSS hﬂ
= Horkspace Command Bars
General .
Display Menu Bar Size
Edit [] Context Menu Bar Button: Border:
Snap to Objects Skatus Bar I 1
Dymamic Guides Standard ama
Warnings Property Bar
Toolb
¥BA E TDD o Default Button Appearance
Sawve ext
Memory [] Zoom DeFault
FlugIns [ Internet
o Text [ Prink Merge
 Teolbox [ Transform Other
= Custemizatien M | 10 Show title when koalbar is floating
Command Bars
Commands=
Color Falette Select Visual Basic
Application for applications
+- Document
+- Glabal
Mew ] [ Reset ]
[ [0l 4 ] l Cancel ] l Help l

Figure 1-2
(2)As shown in figure 1-2, select Visual Basic for applications, and then click on Ok buiton.
Now the main menu of CorelDraw is shown in figure 1-3:
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Bex Visual Basic for applications tool bar - @1
B i Mty BHl .8 x
H 0O [ [ O, - 5% oo b BT | @
= e

H Ad IE Eégjgm 5 |QE| g Units: millmeters (1] @254 mm 3 o, Egg o
|E[:§: 5 3lJIEI 2DID 1DIU DI 1EIID ZDID 3lJIEI
fé; =

Al i

PEEEBRFEODRR
10

millirmeters

M+ 1af1 + M% Pagel =]

{ 372.533, 353.649 )

= E

Figure 1-3

(3)The CorelDraw configuration is now completed, close CorelDraw.
3. In order to ensure smooth installation, we suggest you to close the Anti-Virus Software first.

RICAME etup
Vi 0.2 exe
_ VEDCAM3.0 3.00 In. ..
4. Double click on .

1-4 will pop up:

, the software installation menu as shown in figure

Welcom to use{R<aH {3 H )

install USB drive

AutoCAD Laser. Select Core/Draw _Laser

Install Driver/DEzhoEdE /( 1. Includes two options: Core/Draw Laserand
/,
[~

Type/#SBL:  [Corzllran_Laser 2. Includes three options: Simplified Chinese,

W\ Traditional Chinese, English. Please select the

Larmagze/iE S : Engzli=h
e — software language you need.

[ Locate install path/E{fIZHERT

Install /5 T IE 3. Click on this button to install.

Figure 1-4 software installation menus

(5)  Click [Install Driver/3x#)j%%¢] to install USB drive:
If there are hardware installation prompts, choose continue until the installation is complete.
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Hardware Installation

L] E The saftware you are inztalling far this hardware:
[ ]
USE Senial Corvverter

has not paszed ‘Windows Logo testing to verify its cormpatibility
with ‘windows %P, [Tel me why thiz besting is important, |

Continuing your installation of this software may impair
or destabilize the correct operation of your sypstem
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
pazsed Windows Logo testing.

LContinue Anway ] EéTDF'Installatinn |

After installation ,the following dialog box appears, indicating the successful installation of
USB drivers.

RlLaserSetUp §|

L}
\‘Er) FTDI drivers have been install successfully inskalled!

As shown in figure 1-4, select Core/Draw _Laser, select software language, then click on the
/nstall button, a prompt menu as shown in figure 1-5 will pop up to show successful

installation.
RlLaserSetUp E|
\i!) Install Finish!
Figure 1-5 the prompt for installation completion
5. Installation completion.
1ll.1.3.2 Startup

1. Open CorelDraw11 or CorelDraw12, will pop up the main menu of CorelDraw as shown in

figure 1-6:
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Figure1-6 CorelDraw main menu

You can drag LaserUsing toolbar freely to the position you accustomed to, for example, as

shown in figure 1-7:

LaserUsingtool bar

Tl eocainioi) 12 — [Grugiinl] - B[]
il-] File Edit ¥iew Layont ferange Effects Bitmaps Text Tool=z Windew Help - |5 x

low i 8. - %/ 1o =1 5

E Besom 20 | @l &) wee tmoters [ #2540m f LI
== IPET 200 ] A 300 40 millimeters

Y B 1 Laser Processing button AT / Lo B
A, = , ]
2 ] ,

o | ] Setftings button

| |

A=

ol 1 Import DST/DSB data button

B g
B

2|5

#l

|

.,

@: E L]
@ |E]M +  1of1  + M _Pagel L m

P =<
(335,632, 352.567 ) Mext click for Drag/Scale; Second click For RokatefSkew; Dbl-clicking tool selects all objects; 5... .@ - Y
Figure1-7
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lil.1.4 Operation instruction of Core/Draw_Laser

ll.1.4.1 Settings of the seftings dialog box LaserUsingtool bar Settings button
Tl coeaiyieaf 12 — [Sragiinl] = [B]x]
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{335,632, 352.567 )  Mext click For Drag/Scale; Second click For RotatefSkew; Dbl-clicking tool selects all objects; S... ﬁ -
Figure1-8

As shown in figure 1-8, click on the button Seffings in the LaserUsing toolbar, the Seffings
dialog box as shown in figure 1-9 will pop up:

File format
(OPLT - HPGL Plotter

(® 4T - Adobe Illustrator
Curve precizion(%): 80.00

Curve precision (%):

[pelste repeated track

Speed unit: |mms v
Language/f8S: |English w
[ Code setup... |
[ OK ” Cancel ]

Figure1-9 Seftings dialog box
1. Selection of #ile format
(1) Sefttings of CorelDraw_Laser (CorelDraw direct output software)
Supporting two formats, PLT-HPGL Plotter and Al-Adobe lllustrator
a. Generally, we should select “Al-Adobe lllustrator’ and set the “Curve Precision” between 80
and 100. The higher the precision is, the smoother the curve is, and the relevant cutting speed
is faster.

Note: If the precision is set too high, it may lead to the phenomena that the laser head is
dithering when processing, in this case, we should adjust the precision value lower accordingly. If
it is set too low, the exported curve may be unsmooth (or even turned into a straight line), in this
case, we should adjust it higher accordingly.
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b. Select “Al-Adobe lllustrator”, if you find the graph is abnormal during the output processing

(for example, there is one more line segment when outputting the graph), you can select
“PLT-HPGL Plotter”.)
(2) Settings of AutoCAD_Laser (AutoCAD direct output software)
It only supports the file format of “DXF-AutoCAD File”.
a. Curve precision
It is generally set between 80 and100. The higher the precision value is, the smoother the
curve is, and the relevant cutting speed is faster.
Note: If the precision is set too high, it may lead to the phenomena that the laser head is

dithering when processing, in this case, we should adjust the precision value lower accordingly. If
it is set too low, the exported curve may be unsmooth (even turn to a straight line), in this case, we
should adjust it higher accordingly.

2.

b. Whether to Oufpout fext

If you need to output text, select it, if not, don’t select it.

Whether to Delefe repeated track.

If this feature is selected, the software will delete repeated tracks automatically. It will only cut once
for outputting and for several times for the contrary.

For example, draw two overlapped rectangle in CorelDraw (as shown in figure 1-10), if you select
Delefe repeated track, the rectangle will only be cut once when output cutting. If you don’t select it,
the rectangle will be cut twice.

A (a) D (d)

B (b) C(o
Figure 1-10. Two overlapped rectangles

Note: if you select Delefe repeated track, it will influence the speed for opening the software. So
normally, we don’t select it (especially for figures with too much data).

3.

4.

Selection of the Speed unit
It is very convenient for users to set the speed when using the software. Users can select the speed

units of meter/minute or millimeter/second according to their own habits. All the speed
values used in the software interface to be set by users should adopt the selected unit.
Selection of Language.
Users can select the language shown in the menu according to their own requirements,
such as Simplified Chinese, Traditional Chinese or English.

5. Code setup

Manufacturers use this function to set manufacture code and users’ time limit code.
The steps of setting code are as follows:

6. (1) Click on the Code setup button, the dialog box Input manufacturer code as shown in figure 1-11 will
pop up:
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Input ¥endor Password §|

— : /V 1. Input 6 bit manufacturer code

Figure1-11
(2) Click on the Ok butfon, the dialog box Code sefup as shown in figure 1-12 will pop up:

Password setting §|

I Yendor Fassword ]

I Period Passwerd ]

Figure 1-12

a) Setup of the Manutacturer Code
Click on the Manufacture code button shown in figure 1-12, the dialog box Sefup Manufacturer
Code as shown in figure 1-13 will pop up:

Vendor Password Setting E|

1. Input the old manufacturer code
01d Fassword:

; 2. Input the new manufacturer code
Hew Password:

Confirm
3. Repeat the new manufacturer code

4. Modify password

Figure1-13

After inputting the o/d code, the new code, confirmed code, click on the Modify button as shown
in figure 1-13. When the modification is successful, a menu as shown in figure 1-14 will pop up to
show that the manufacture code has been modified.

LaserWork §|

' E Passwiord modified success!
L

Figure 1-14
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b) Setup of the 7ime Limit Code

Click on the 7/ime Limit Code button in figure 1-12, a dialog box Sefup 7ime Limit Code as shown in
figure 1-15 will pop up:

Period Password Setting §|

Ly 1. Number s of Period

Humber of Feriods 1

S . 4»| 2. Input Vendor Password
¥endor Password: **W_—

Gee 1 ———3® | 3. Input Period Interval
[JVariable Period 1% | 4. Set Variable Period
| Cancel | [Save Fazewor -l} »

5. Save Password

Figure 1-15

After inputting the Encrypt perioad, the Encrypt time, the Manufacture code and select USB port in turn,
click on the Save Code button, a menu as shown in figure 1-16 will pop up:

Savein: | S Local Disk [E:) v QT m

1. Input the file name
of the code file 2. Save to file

\ 7

Flepame: | o | Lsde |

Save as lype: | Test files{* bt v | [ Cancel ]

Figure 1-16

Input File Name and then click on the Save button as shown in figure 1-16, a menu as shown in figure
1-17 will pop up to show that has been saved successfully.

LaserWork §|

' E Create Password Success!
L

Figure 1-17
Additional note:

@ Introduction of code file formats. For example, suppose there is a code file 1.txt as shown in
Figure 1-18:
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' 1.txt - Notepad
File Edit Format Yiew Help

1 : B454D5G
2 1 BR4TUS

S4WTVH|

Figure 1-18
Where, “1: 8454DG” indicates that the code of the first period is 8454DG; “2: BR47U3” indicates that the
code of the second period is BR47U3; “N: XXXXXX” (N is an integer, X represents any digit or letter)
indicates that the code of the Nth period is XXXXXX. At last, “S4W5VH” (the text at the last line) indicates
that the code for releasing the limitation is S4W5VH.

If you need setting variable day for each period, can check Variable Period.

Period Password Settaing [E|

Humber of Feriods 52

..................

Vendor Password: | Ak

Period Interwal:

[#] ¥ariable Feriod

[ Cancel ] [Save Paz=word

Check Variable Period, and click Setting
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Period day setting EI
Period HO Feriod Inte. ..
1 1
o [2
£ *

After setting successfully, quit this dialog, and save password

(2 How to release the code limitation when the manufacture code expires?

When the expiration date of the limitation code set by the manufacture arrives, a menu as shown in figure
1-19 will pop up once you open CorelDraw and click on any button in the Laser Using tool bar in figure
1-7:

Input Password E]

Hote:The Machine be locked, F1

/ 1. Input the code

FPaszword (Ha. 1) |

2. Confirm

Figure 1-19
As shown in figure 1-19, press the Ok button, a menu as shown in figure 1-20 will pop up:

“NO.1” indicates Input Rassword
that the code of ~ Hote:The Machine be locked, Fleas
the first period is / 1. Input the code of the first period
requested. Fassword (Ho. 1) |
Figure 1-20

Instruction: Figure 1-20 shows that the code of the first period is required, now the user can input the
code of the first period or the code for releasing the period. If you input the code for releasing the period,
the machine would not be locked any more in the future.

Input the Code and select the right USB pori, then press the Ok butfon as shown in figure 1-20;
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1il.1.4.2 Importing Dst/Dsb files data

LaserUsing tool bar

Import Dst/Dsb data button

TlGnesinmay 17 — [Seayiicl] _
||-] File Edit Yiew Layout jrrange Effects Bitmaps Text Tools Window Help f = el
IR T RN o MBI
Tlz10.0 el R (am] , . " | e = | Be.as =] === =
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:é; X
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R 1
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B ]
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#| ]
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@1 E-: rl
Nk -
= Tl 4
& |E]W + 1o0f1 + MY Pagel 1< m 5]
P >
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Figure 1-21

As shown in figure 1-21, click on the /mport Dst/Dsb file data button in the Laser Using tool bar, a menu as
shown in figure 1-22 will pop up:

CIMGEMING. ST 1. Select one DST/DSB file you
need to import

2. Click on the “Open” button

/

/
Flepame:  [QNGMINGDST | Coed ]

Files of type: | Embraider Files v | [ Cancel ]

Figure 1-22

Select one DST (or DSB) file you need to import (e.g.: QINGMING.DST in the dialog box as shown in
figure 1-22. Then click on the Opern button, the imported DST (or DSB) file will be showed in
CorelDraw, just as shown in figure 1-23:
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Figure 1-24 (CorelDraw shows 2 figures and one picture of “wild wolf".)
As shown in figure 1-24, click on the “Laser processing” button in the Laser Using tool bar, a menu as
shown in figure 1-25 will pop:

Label 4

|Labe| 5 | Label 6: show the figure to be processed

lLabel 1 ||Label 2 | [Label 3

Frocessing. .. Speddl .. Min|Fow. .. Max Fow. .. (o5 @

BRIz Cut| 0. 00p 7,000} 100, 000 Tes
- Cut L0 00f 0. 000 100, 000 fe=
EMFL Caser Secan 10. 00 W] 100. 000 fes

< >
Laser export |General settings | Machine para | Document | Marmal ro ¢ %

Cutting @ptimized route] Scamming (Rewerze interwal)

Export by the order of layers Speed nm =) Rewverze ...

[¥|Inzide to outside

Single inmer to outer,F... %
I:‘Array

Height: |10 Dir: |Up to ... ¥ ¢ >

I:‘Space Repay Optimize [ B i ] [ Tel

Dﬂriginal route Or editing rout.

Line/colunn setup [l Feeding Count:

£ Hun: |1 T Hum: |1 Feeding Distance:

X a T a

DEnable center distance [Track Frame] [ Cut Frame ] - - .

[JOverall handle T }l

[ Bectisiinisgbaadetive ] Fosition |Current po... COM3 v isp\ay | A1l Layer W

[ SavelollFile ][ TF1lelut ][Pausej'continu.e ][ Stop ][ Process ] H I Backgroun B

Figure 1-25 Main menu of “Zaser processing”

Label 1: Each layer corresponds to one item, every item includes: color of this layer (if the layer is
bitmap, it will be labeled BMP) and the parameters of laser processing (e.g.: processing
mode, speed, minimum power etc.);

Label 2, Label 3: The array order of layers in Label 1 can be changed by clicking on the Up and the
Down buttons.

Label 4: shows how to display figures, there are three options (a// /ayers, chosen /ayer, hide). Note:
When the figure you want to display is very complicated and causes the display speed to
be too slow, you can select A/de;

Label 5: There are two options (white and black) for the background color. In general, we select White

in CorelDraw_Laser and Black in AutoCAD_Laser.

Label 6: Display figures according to the selection of Label 4 and Label 5.
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1l.1.4.3.1 The setup of layer parameters

Double click on corresponding option of the layer by the left key of the mouse

Layer
L .. Processing .. eedl. . Min Pow. .. Max Fow. .. e
Bl =z er Cut 10000 0. 000 100, 000 es
- ot Z |in.0oo 1. 000 100. 000 ez
ENFl [aser Secan 10. 000 1. 000 100. 000 fex
4 >
Lazer export |General settings | Machine para | Document | Manual vu ¢ %
Cutting (Optimized route) Scarming (Reverse interwal)
Export by the order of layers Speed (nmfs) Rewersze ...
[¥|Inside to outside
Single inmer to outer,F... %
D.‘\rray
Height: |10 Dir: |Up to ... ¥ < >
DSpace Repay Optimize [ Add. . ] [ Del
DDriginal route Or editing rout
Linefcolunn setup [ Feeding Count:
1 Fun: |1 T Fum: |1 Feeding Distance:
X 1} T 1}
|:|Ena'ble center distance [Track Frame] [ Cut Frame ]

D Owerall handle

[ Bestrewing breadth. .. ] Pesition |Current po... COmM3 w Display A1l Layer %
[ SaveTollFile ][ UFilelut ][Pausefcontinue ][ Stop ][ Frocass ] H I Background flhlh- m w

Figure1-26

As shown in figure 1-26, double click on corresponding option of the layer requiring modification of
parameters with the left key of the mouse, a menu as shown in figure 1-27 will pop up:

Layer Parameter

ere are two options: Yes and Mo. Select Yes, the corresponding
layer will be exported for processing; Select Mo, it will not be exported.

I= Output:

Speedimmfs): |10

——»The speed of laser processing; speed will influence the processing
effect: the slower the speed is, the better the processing effect is
Min Fower (%1: |0 and the smoother the track is; the faster the speed is, the worse the
s \ processing effect is; if the speed value is zero, it means the default

: \ power is used (the speed set on the panel of the machine). Please

If Blowing: |yes input suitable speed value!

Sesl (0-Smm): |0 and the lower the value is, the weaker the laser is. If the value is zero,
means the default power is used (i.e., the power set on the panel of
the machine).

Bl Processing mode, meaning the mode to process corresponding
layer; If you select vector layer (color layer) currently, there are three
options: Laser scanning, Laser cutting and Laser dotting; If you
select bitmap layer (BMP layer) currently, there is only one option:
Laser scanning.

[l

TAV/-NTEP-V-N that tha 1z doare lon o o ] P9~ B
\TOUULAl T SCTUTatuTTc ve LU TayCT 1S5 STICUITUT

Proceszing Mode Laser Cut b 1
The range of power value is 0~100, it means the intensity of laser
during the process; the higher the value is, the stronger the laser is,

Open Delay(ms): 1]

=)

P
3
b
]

Ok | | Cencel |

Figure1-27
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If the laser is too strong during the whole process, you should set the minimum and maximal power

lower, otherwise, set them higher;

If the laser is too weak in some places during the process, you should set the maximal power higher;

If the laser is too strong in some places during the process, you should set the minimum power lower.

(2) Setup of processing parameters under different Processing modes
Processing modes include Laser scan, Laser cut and Laser dof. The bitmap layer (BMP layer) can be
only processed by Laser scan.
(D Setup of processing parameters in the Laser scan mode
As shown in figure 1-27, if you select processing mode of Laser scan, the menu is as shown in figure

1-28 (or figure 1-29).

Layer Parameter @ Layer Parameter g

I= Output: Yes b I= Output: Te= W .
Speed(umf=): |10 Speed(mumf=): |10
Min Power (%1: [0 Min Power (8]: |0
Max Power (81: 100 Max Power (3]: (100
If Blowing: Tes e If Blowing: Tes w
Procezsing Mode: Lazer Scam W Procezsing Mode: Lazer Scan W

DHegative 1
DRamp Effect

Ramp Length (nm):

Famp Length (mm):

Overstriking: Un-pr... Overstriking: |Un—pr... #
Soan Mode: |[A_sWing ¥ Soan Mode: |A_Umi... %
Interwal (mm): 0.1 Interwal (mm): 0.1
T e e e

Figure1-28 Laser scanning parameters of the Figure 1-29 Laser scanning parameters of the
vector layer (color layer) bitmap layer (BMP layer)

The Vector layer (color layer) doesn’t support Negative engraving and Optimized scarn.
Negative engraving.’ If you do not select NMegative engraving, the black dots which run across the bitmap will emit
laser and the white dots which run across the bitmap will not. If you select Negative engraving, the white dots
which run across the bitmap will emit laser and the black dots which run across the bitmap will not.
Optimized scan. If you select Optimized scan, it will adjust users’ setup of Scarnning inferva/ automatically
to the best values and optimize the scanning effect. Otherwise, we should select Scarnning inferval as set
by the user for scanning. We generally select the Optimized scanning.

Ramp effect. If you select Ramp effect, it can make the track edges of scanned figures presented as
ramp in order to attain solid effect.

The Minimum power set currently corresponds with the power of the top ramp, the Maximum
power corresponds with the power of the bottom ramp. You should set the same value for the

maximum power and the minimum power if you do not select ramp effect.
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Ramp length. the length of the ramp

Overstriking. \ncludes Un-process, /ntaglio and Rilievi
No processing: does not adopt overstriking.
Intaglio. when selecting the intaglio font (please refer to the attachment below for what is font intaglio), the font will
receive overstriking processing.

Note: if you select Ri/evi for Overstriking when selecting intaglio font, the font strokes will be thinner
instead of thicker.

Rilievi: when selecting rilievi font (please refer to below attachment for what is font rilievi), the font will
receive overstriking processing.
Note: if you select Intaglio for Overstriking when rilievi font, the font strokes will be thinner
instead of thicker.
Additional note: What are font intaglio and rilievi?

Font intaglio: the text does not have the outline border. It is the text itself that is to be scanned, please

see the figure below: We | C O m e

Font rilievi: The text has the outline border, it is the figure base to be scanned, please see the figure

Welcome

Scan modes. including X unilateralism, X _swing, Y unilateralismand Y _swing.

X unilateralism: The laser head scans figures back and forth at the level direction, but only emit laser
toward one direction. For example, the laser head emits laser when scanning from right to left, but not
emits laser when scanning from left to right.

X _swing: The laser head emits laser and scans figures back and forth horizontally.

below:

Y unilateralism: The laser head scans figures back and forth vertically, but only emit laser toward one
direction. For example, the laser head emits laser when scanning from the top down, but not
emits laser when scanning from the bottom up.

Y swing. The laser head emits laser and scans figures back and forth vertically.

Note: We generally adopt the scanning mode of X_swing.

Inferval: The interval between the current line and the next line to be scanned by the laser head. The

smaller the interval is, the darker the scanned figures is; If reverse, the weaker.

Recommendation: @ The scanning interval is set below 0.1mm for vector layer (color layer) in

general. @ The scanning interval is set above 0.1mm for bitmap layer (BMP layer) in general, and
then the Minimum power and Maximum power should be
changed to attain the perfect effect of the scanned figures.
(2 Setup of processing parameters of Laser cut
The processing mode is Laser cut as shown in figure 1-27.
Seal (mm). it means the length of the extended line at the closed figure interface. We set it at zero in
general; if the value is set above zero (0-2mm), it is usually used in the craft of cutting polymethyl
methacrylate to eliminate the obvious heave effect.
) Setup of processing parameters of Laser dot
Laser dot: drawing dots along the track of the figures.
As shown in figure 1-27, select Laser dof as the processing mode, the menu will be showed as figure

1-30:
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Layer Parameter -

I= Output: |Yes - .

Speed (nmfg): |100
Min Fower (%): |30

Max FPower (%) : an

i T = The time for emitting laser on

: one dot during the process. The
Processing Mode: Dot -

/ higher the value is, the darker
|
—————""| The interval between the dots

Dot interwal (mum): |2

Dot lenzth (mm): |0
\ Dot length, for cutting dash line

D Cent ei\dot\‘ I

Only dot at center

Dat time(=): m

0k Cancel

Figure 1-30

11.1.4.3.2 Laser export, introduces Setup of related parameters and how to export the
figures to the machine for processing.

Label 1| |Label 3 Label 11 || Label 2 Label 4 Label 6 Label 5
Layer
L...| Processipng. .. Speed (] . Min Fow. .. Max Fow. .. (M
EMFT Cfzer Sc4f io.oo0  |7oon [{oa. 000 k=
Rl =-r Cut 0. 000 7 000 | ] TE=
= Cut {0,000 7. 000 J{00 o000 k=
£ >

Laser expport | Jeneral settings | Machine para Daument Manual fu ¢

Cuttingptim}zed route) Scamning (Jeverze intervyl)
[ |Expart by fhe order of layers Speed (mm/s) Reversze
[¥|Inside to jputside

Single igner to outer,F... #

Dﬂrray

Height: |10 Dir: |Up to ... % < by
I:‘Space Eepdy Optimize [ Wi ] [ Del
I:‘Uriginal foute Or editing rout.
Line/column fetup D Feeding Count:
& Hum: 1 T Hum: |1 Feeding Distance:
X a T i}
[[JEnatle center distance [Track Frame] [ Cut Freme ]

DDverall handle o
[ Bestrewing breadth. .. ] Fozition Cwrrent po... ¥ ' CON3 b Display A1l Layer ¥

[ SaveTolFile ][ TFi1lelut ][Pause[continue ][ Stop ][ Process] H I Backzround |White b

\’ \ \/ gure 1-31

Label 7 Label 8 Label 10 Label 9
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(1) Setup of Cutting (optimized route) (as Label 1 in figure 1-31)
It is used to optimize the cutting route during laser cutting.
@ Export by the order of layers
Export layers to the machine for processing in turn according to the order of layers from the top down
as shown in Label 11. For example, the black layer is above the red layer in figure 1-31, then we have to
cut the black “Welcome to use” before cutting the red “Welcome to use”.
We do not select (check) Export by the order of /layers in general.

@ Partial optimization
Search the point which is the nearest to with the laser head and then cut the rest part of the figure every
time. We select Partial optimization in generally.

()/nside to outside and start point
If there are other figures in the closed figure, we should cut all the internal figures first and then cut the
closed figure.
If you select /nside to outside first, then select start point it will find a perfect point in the closed
figure and start to cut.
When select /nside fo outside and start point for special techniques such as polymath
methacrylate, while in normal cases, we do not select /7side fo outside.

@ Block process

The system will se/ect Block process automatically.

1.Setup of Height and dir. Different figures require different Hejg/if values. The height is always set between 10 and
20mm for figures not well-regulated. For Dir;, you can select 7op fo bottom, From the botiom up, Left to right or
Right fo /eftaccording to the requriemets of processing.

Note: For well-regulated figures, you must set appropriate height value to achieve perfect cutting
order. For example:

a. Cutting Text, set the He/ght value the same to the height of the text font.

b. Processing Light blocking board formed with short line segments, set the Ae/jg/f value less than
the space between two lines.

2. Setup of Array

Usually, we do not select (check) Array, but for cutting array figures, we can select the feature.

For example: you can select Array when cutting array circles, set the Ae/ighf value less than the diameter
of the circle.

® Original route

Once you select Original route, export according to the order of layers, the route optimization of Part
optimization, From the inside to outside and Block processing will be invalid. It shows that it will be
exported to the machine for processing according to the drawing order of layers in CorelDraw.

We do not select (check) this feature in general; special route optimizing arithmetic processing is
not needed inside the software itself, so it does not need any waiting time when exporting figures
to process. So you can select this feature and need not wait for the software arithmetic
processing when exporting the figure with a large amount of data.

(2) Setup of Scanning (Reverse interval) (as_Label 2 in picture1-31)

The edges of figure may be unsmooth because of the extending of machine strap when the laser bilaterally
scanning the picture. So we increase the reverse interval to for the amendment. There is certain reverse interval
under certain speed; Generally speaking, the fasterthe speed is, the bigger the reverseinterval is.

(O add reverse interval
Left click on the aa@ button in Label 2 block of figure 1-31, a menu as figure 1-32 will pop up:
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x]

= — 1 | Input laser scanning
Speed

Speed(mmis)

e ) S — | Input reverse interval

Figure 1-32

Input Speed (e.g.: 8) and Reverse interval (e.g.: 0.3) as shown in figure 1-32, then click on the OA’button, a menu
as figure 1-3 will pop up 3:

Layer
L... Processing .. Speed(. .. Min Pow. .. Max FPaw. .. (Il
FMFI_[Caser Scan [0 OO0 000 JOo 000 Jles |
RSN Cut 0. 000 3,000 i00. 000 Tes |
- Cut Ji0. 000 [3. ooo Ji00. ooa [Fe= |
£ 2|
Laser export |General settings | Machine para | Document | Manual ru One item “8.00 I 0.30” added
Cutting (Optimized route) Scanning (Reverse interw - T
r‘ExDort by the order of layers Speed (mmi =)
Inside to outside 5. 000
éSingle inmer to outer,F... ¥
=
Height: |10 Dir: gUp to ... W £ by
DSpace Eepay Optimize [ add ] | Tel |
I:‘Uriginal route Or editing rout.
Line/column setup D Feeding Count: |1
& B 1 i 1 ............ Feeding Distance:
X o | ¥ 0 [
I:‘Enable center distance [Track Frame] [ Cut Frame ]
Dﬂverall handle o : PR b b
[ Bestreving bresdth .. | Fosition |Current po... COMS | Display ALl Leyer v
[ SaveTolFile ][ VFilelut ][Pausefcontinue ][ Stop ][ Frocess ] H I | Background 'thte lllllll M

Figure 1-33

We can see in figure 1-33 that one item “8.00 | 0.30” has been added in the block of Scarnning (Reverse
scanning).This shows that the laser scanning speed is 8m/min and the reverse interval is 0.30mm.
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Following the same operation, we can add one more item “10.00 | 0.40” as shown in figure1-34

Layer

L... PFrocessing .. Speedl. .. Min Fow. .. Max Fow. .. [ W@ﬂ @@ @
EMFL  Caser Scan 10. 000 1. 000 100, 000 fe=
N z=r Cut 10. 000 0. 000 100. 000 Fes
= Cut 0000 3,000 00000 Fe= W@ @@ @
- @e._,hh

There are two items in the reverse interval list now: “8.00 | 0.30”
and “10.00 |0.40”

Laszer export |General settings | Machine para || Documen

Cutting Optimized route) Scanning (Rever S8 TRTervart

[ 1Export by the crder of layers Speed inm =) werze | .

Inside to outside 5,000 0.300

Single inmer to onter,F. .. % 10, 000 0. 400
Dﬁ\rray

Height: |10 Dir; |Up to ... ¥ £ >

I:‘Space Repay Optimize | A | [ Del

Dﬂriginal route Or editing rout:

Linefcolunn setup [l Feeding Count:

¥ Hun: |1 T Hun: |1 Feeding Distance:

A u] i u]

DEnable center distance [Tr“k Frame] [ Eut Frame ]

I:‘Uverall handle o

[ Bestrewing breadth. .. ] Position |Current po... ¥ COM3 b Display [All Layer ™

[ SaveTolFile ][ UFilelnt ][Pau.sefcontinu.e ][ Stop ][ Frocess ] H T Background White o~

Figure 1-34

At this time, the reverse interval is 0.30mm when the laser scanning speed is 8m/min;

the reverse interval is 0.40mm when the laser scanning speed is 10m/min.
Thus, if we scan the figure with laser at the speed of 9m/min, the reverse interval will be 0.3+(9-8) / (10-8)
x (0.4-0.3)=0.35mm; If we scan the figure with laser at the speed of more than 10m/min, the reverse
interval equals the reverse interval of 0.40mm at the speed of 10m/min. If we scan the figure with laser at
the speed of less than 8m/min (e.g.: 6m/min), the reverse interval will be 6/8x0.30=0.225mm; so we
don’t need to add a reverse interval for every speed value.

(2 Modifying reverse interval
Double click on the reverse interval item to be modified in the Scanning (reverse internal) block with the
left key of the mouse, such as “10.00 |0.40”, a menu as figure 1-35 will pop up:

%]

Speedimm/=) |10
——1— | Input reverse interval value

Reverse interwal (mm) |04

o0k R Cancal

Figure 1-35

As shown in 1-35, input proper Reverse inferval (e.g.: 0.45), then click on the o4 button, now the
reverse interval corresponding to the scanning speed of 10m/min has been modified to 0.45mm.
@ Deleting reverse interval

Click on the reverse interval item to be deleted in the Scanning (reverse infer) block with the left key of
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the mouse, and then click on the De/efe button.

(3) Settings of the /ine&column sefyp (as Label 3 in picture1-31)
One figure is copied to multiple lines and columns to be exported to the machine for processing.
Suppose we need to export a circle as shown in figure 1-36:

copied into 2*3=6 copies, which are exported to

This means that the current figure (a circle here) is The interval between The width of current
two adjacent circles in figure (here is a
the direction of the circle)

Y-axis

machine for processing as 2 lines and 3 columns.

Prdeeszing .. Speed(] ..

(o]

Cutting (Oppimized route)

[Export v the order of ldyvers
Inside o outside

Single|inmer to outer,F| . #
Dj'u'ray
Height: |10 Dir: |Up to J.. ¥

DSpace Eqpay Optimize
DUrigina] route Or editing rout.

Linefcolund zetup

£ Hum: |2 T Hum: |3

% = W 4

DEnable enter distance
Dﬂverall handl e

[ Besfrewing breadth. .. ]

=

Lazer expor General settingd | Machine para | Docum

t | Marmal ru 4
Scanning (Reyerse interwal)

=1 Beverse ...

0.300
0. 400

add.. | [ 1

D Feeding Count:

Feeding Distance:

[Track Frame] [ Cut Frame ]

Fosition |Current po... COM3 LY Display [#1]1 Layer %
[ SavelolFille ][ Filelut ][Pau.sefcontinu.e ][ Stop ][ Process] H I Background White b

[N

v

N

The interval between two adjacent The height of the current
circles in the direction of the X-axis figure (a circle here).

Figure 1-36 exporting a in multiple lines and columns

Introduction of parameters in Line&column setup is shown in figure 1-36.
If we adopt export and processing according to the Line & column setup in figure 1-36, then the actual
figure exported is as figure 1-37:

Figure 1-37

\ / centers of the adjacent upper and lower circles,

Instruction:
The line space is the distance between the

51.736+4=55.736mm.
The column space is the distance between the

centers of the adjacent left and right circles,
51.736+5=56.736mm.
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Bestrewing breadth setup.

This allows us to decide how many lines (Y) and columns (X) can be exported at the most according to
the breadth and the range interval set by user.
Operation procedure:
(@ Click on the Bestrewing breadth butfon, a menu as figure 1-38 will pop up:
Bestrewing breadth §|

Figure 1-38
2 As shown in figure 1-38, input the actual X treadth (e.g.: 1000mm) and the Y breaadlth (e.g.: 800mm),
click on the OKbutton.
A menu as figure 1-39 will pop up:

The Y interval is 51.736+4=55.736mm
according to the Y breadth of 800mm, and
the Y number is 14.

The X interval is 51.736+5=56.736mm according
to the X breadth of 1000mm, and the obtained X
number is 17.

Processing. | .

Laser export |Gendral settings | Machine para | Docume

Cutting Optimizef route)

[1Export by thd order of lavers Speed (m S
:!:nside to ouffside 5000 0,300
|Single inmey to outer,F. .. 0. 400
Di\rray
Height: |10 Jir: |Up te ... ¥ by
A e e
e
DDriginal route Or editing rout.
Line/column seq:lp D Feeding Count: |1
i I Feeding Distance:
X 5 | ¥ 4 [
DEnable center distance [Track Frame] [ Cut Frame ]
Dﬂverall handltafiiises e el s L s S S G
[ Bestrewing breadth. .. ] Fosition Cu.rrentpov COMZ el Dizplay |#ll Layer *
[ SaveTolFile ” UFilebut ][Pause.frcontinue ][ Stop ][ Process ] H I | Background 'ﬂ'hlte _______ e |
Figure 1-39

(4) Setup of #rack framme (as Label 4 in figure 1-31)

Cut along the side of the minimum circumscribed rectangular which contains the current graph.

Operation procedure: set the laser Power and cutting Speed, select correct USB por?, then click on the
Run button.

Let’s illustrate the meaning of #ack frame with an example, as shown in figure 1-40:

Figure 1-40
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The circle is an actual graph, the red rectangular is the minimum circumscribed rectangular of this circle.
The laser head will cut along the rectangular after you click on the Auws button.

(5)Port selection (as Label 5 in figure 1-31)
Select correct port according to the USB port which connects the computer with the machine.

(6) Selection of Originn (as Label 6 in figure 1-31)
Originincludes three options: Current position, Original anchor point and Machine zero.
Show the position to which the laser head will return when the figure processing is finished.

Current position. the laser head returns to its position before the processing.

Original anchor point. the laser head returns to the previous anchor point. The anchor point can be set by
the keys on the machine panel.

Machine zero: the laser head returns to the limit point of the machine.

(1) Export (as Label 7 in figure 1-31)

It saves the figure processing data processed by the software to file.

The saved file can be downloaded to the machine. We can start the file directly for export and
processing by the keys on the machine panel.

Operation procedure: Click on the Export button, then input the name of file to be saved in the dialog box
and click on the Save button.

(8) /mport (as Label 8 in figure 1-31)

Open the saved file and export it to the machine for processing.

Operation procedure: Click on the Import button, then select the file you need to process in the dialog box
and click on the Open button.

(9) Process (as Label 9 in figure 1-31)
Export the current figure to the machine for processing.
Operation procedure: Click on the FProcess button directly.

(10) Display of the current operation status (as Label 10 in figure 1-31)

It is used to show information on the status of the user’s current operation. For example, if you select an
incorrect USB port, it will show “Transfers failure, the serial port can’t be opened” when you click on the
Process button.
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lil.1.4.3.3 General Settings

Layer

Click on the General setting%., — wezm . o
button to switch from anjh—-

other menu to this menu

Label 1

A

N

Label 2

Lacer export | Geheral sepfings | Machine para" ]]ocu.w ” Manmal ru ¢ *

fuis Mirror

Laszer head #osition

Axis X Mirror O O @

2 (8 (9]

Axis T Mirror (@) (@) (]
¥ Space Repay Y Space Repay

I Repay: I:I T Repay: |9 Label 3
¥ Space (um): ICI ¥ Space (nm): 0

¥ Test | [ T Test
/
Line-To-Line [0 !
b By 0300 e e e S e T
Figure 1-41

(1) Axis Mirror (as shown in Label 1 in Figure 1-41)

Generally, Axis direction of mirror is based on the actual location of the limit or home of machine. The
default coordinate system if Descartes coordinate system, and zero in the bottom left. If the zero point of
the machine is top left, then X-Axis does not need to mirror, but Y-Axis need to mirror. If the zero point of
the machine is top right, then both X-Axis and Y-Axis are all need to mirror. In addition, this function can
also use to other application for mirror.

Note: If the settings are inccorrest, the exported figures may be reverse or upside down..

(2) Laser head (as shown in Label 2 in Figure 1-41)
Position of Laser head means the location laser head relative to the graphic.
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Note: You must ensure correct /imit position settings (as shown in Label 1 in Figure 1-41).

(3) Line-fo-line precision (0-2mm) (as shown in Label 3 in Figure 1-41) settings

If the distance between one end of a line segment and one end of another is smaller than or equal to this

value, the software will internally consider the two segments to be connected.

For example, please see Fig

If the Line-to-line precision value is set to 0.1mm, as [BC|=0.05mm<0.1mm, AB and CD are deemed to be

ure 1-46:

Figure 1-46

Note:
In the two line segments AB and CD, the
distance between B and C: |BC|=0.05mm

connected (namely, B and C overlap), as shown in Figure 1-47:
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o
/ Note: Points B and C are

considered overlapped now

Figure 1-47
Note: This value is normally set to 0.1mm, for figures with large quantity of data, it can be set to
Omm to reduce the waiting time before the processing.

1ll.1.4.3.4 Machine Para. (Machine parameters)

Layer

L ..| Processing .. Speedl. ..

FEEENCaser Cat | Click on the macthine Para. Button to
switch from any other menu to this
menu

< + ]

Down
| Laser export | General settings| Machine para | Document |Mamual ru ¥ ¥
H Cut parameters e’ [ Axiz parameters L
Idle speed(mnm/s. 200,000 iz H
Idle &ee(mmf=2) 2000, 000 Direction polari Positive
Start speedfmmf: 15. 000 Limiter polarity Hegatiwe
Min hee(mmd=2) 1000, 000 Contrl Mode Ful=etDir
Max fee (mmfs2) 2000, 000 Keying directior Positive
Cutting mode Speed Cuti Step length (um) 3.750
Ao Mode 2 mode Max speedimmfs) 1200. 000
E Sweep parameter: Jump—off speedin 45 000
x Start Speed(mn 10. 000 heoceleration (mmy 10000, 000
¥ Start Speedimn 10,000 v Breadth (mm) 350.000
[ Find Con | [cOM3 v|  Display|a11 Layer v
Save Read frite
H| | I| | Rt About. .. Cloze
Figure 1-48

(1) Machine parameters are described as follows:
A. Laser parameters

e. Laser mode: there are currently three types of Laser devices: home-made glass tube, RF Laser
(pre-ignition pulse not required) and RF Laser (pre-ignition pulse required), the glass tubes adopt
analog quantity for control and RF tubes adopt digital quantity for control. If the machine adopts
home-made glass tube, the laser type should be “Analog quantity”, while if it adopts RF tube, the
duty ratio (pre-ignition pulse required/ not required) should be selected correspondingly. After
modification of Laser type options, the system should be reset, and the modifications should take
effect after the reset.

f. Laser freq. the pulse frequency of the control signal used by the laser installed on the machine.
Max. power (%), Min. power (%) you can set the limit power values for the laser, namely, during
the operation, the max. power set by the user cannot be higher that the max. power set here and
the min. power set by the user cannot be lower than the min. power set here.

h. On-delay, off-delay. if the on/off delay parameter is not 0, when the laser is turned on/off, the laser
will be turned on in advance and turned off behind schedule at the time delay set in advance. The
range for the time delay may be Ous ~ 0.1s.

B. Other parameters

j. reset speed. this parameter decides the speed of the machine to return to the origin when startup,
if the breadth of the machine is too large, you can set a comparatively large value of reset speed,
but do not set it too large, the controller will control this parameter within 50mm/s, namely, any
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reset speed value set by the user exceeding 50mm/s should be deeded invalid.
/dle speed: this parameter decides the max. Speed of all lines not emitting beams during the
operation of the machine. This parameter should not be lower than the lower of the jump-off speed
of the X-axis and that of the Y-axis and not exceed the higher of the max. speed of the X-axis and
that of the Y-axis, if the setting is illegal, the controller will automatically set this parameter within
the range above; a comparatively high idling speed can shorten the operation time of the entire
figure while excessively high idling speed may cause dithering of the tracks, therefore, you should
take all relevant factors into consideration when setting.
Line shift speed of scanning. this parameter is specially used to control the max. Speed of the
scanning to shift vertically from one line to the next line below it. If during the scanning, the line
space is too large or the block space is too large when scanning block figures while precise
positioning for each line or block is required, you can set the line shirt speed of scanning to a
comparatively low value. This parameter cannot be less than the jump-off speed of the
corresponding axis during the line shift and cannot be higher than the max. Speed of the
corresponding axis during the line shift, if the setting is illegal, the controller will automatically set
this parameter within the range above.
Accelerated mode: this parameter decides the acceleration and deceleration mode (S mode or T
mode) of the motor during operation, the motor accelerates and decelerates slowly and smoothly
in the S mode and fast and relatively unsmooth in the T mode; the default mode is the S mode.
Scan mode: There are two modes for your selection: the general mode and the special mode, in
the general mode, there’s no any treatment during the scan, in the special mode, light spots will
be treated. If the special mode is activated, the power of the laser should be increased and
correspondingly, the light spot percentage will be lower and the laser power attenuation will be
higher, to achieve the same depth of scanning, the laser power should be higher. The purpose to
select the special mode is to make the laser to emit beams at high power and in short period,
during deep scanning, the effect of flat bottom can be
achieved, however, if the light spots are improperly adjusted, this effect may not be
achieved and the working mode of high power and short period may influence the service life of
the laser. The default mode is the general mode.
Facula size. this parameter is invalid in the general mode of scanning and is only valid in the
special mode. The controller will control this parameter at 50%~99%.
Array mode: you can choose the swing mode and the one-way mode. The Swing mode: cutting
the array back and forth in order; the One-way mode: always cutting the array from one direction
to another. If One-way mode is selected, all array units have the same movement modes and the
same liquidity of movements; however, this mode will take more time than the swing mode. The
default mode is the Swing mode.
Return positiorr. You can select the locating point and the machine origin. This parameter decides
the position, the locating point or the machine origin, where the laser head stops upon completion
of each operation.
/f Profection on: If the machine is provided with any additional protection signals besides water
protection, you should make corresponding selections in this option. The protection signal is
inputted from universal input port 2 port (please refer to the User's Manual of the main board).
When this protection signal is enabled, the controller will carry out real-time inspection on the
protection signal, if the input is at high level, the machine will be protected and the operation in
progress will be suspended and the laser will be turned off.
parameters
Direction polarity. if a the X or Y axis move against the machine origin when the electrical system
of the machine is reset, that means that the direction signal polarity of this axis is incorrect, at this
time, you should disconnect the axis from the motor driver (otherwise, the inspection of the main
board will be insufficient, which may cause collision of this axis), after D16 on the main board
flashes (which means that the reset has been completed, D16 will go out first each time the
machine is reset and start flashing after reset completion, do not read or write all parameters on
the PC before D16 starts flashing, please refer to the User’s Manual of the main board interface
for the position of D16), modify the direction signal polarity of this axis on the PC, upon completion,
press the Reset button to reset the main board.
Limiter polarify. If when the axis of movement reaches the limit position, a low level signal is
triggered to turn on the LED corresponding to various limit positions and when the axis of
movement departs from the limit position, a high level signal is triggered to turn out the LED
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corresponding to various limit positions, the limit polarity is negative; contrariwise, if when the axis
of movement departs from the limit position, the LED corresponding to various limit positions are
out and when the axis of movement reaches the limit position, the LED corresponding to various
limit positions are on, the limit polarity is positive. Incorrect limit polarity setting may cause
insufficient inspection of the system when resetting, which may lead to collision of the axes.
Contro/ mode: There are two modes for your selection: the double-pulse mode and the pulse +
direction mode, which should be deiced according to the type of the motor drive installed on the
machine, in general, the pulse + direction mode is selected. After any modification of the control
mode option, the main board should be reset to make the modification take effect.

Keying direction:. After correct setting of the direction polarity of the machine, if the X-axis moves
to the Right when you press the Left button and the X-axis moves to the Left when you press the
Right button, that means the keying direction settings are incorrect and modifications should be
made correspondingly; the Up and Down keys are corresponding to the movement of the Y-axis, if
the Y-axis moves upwards when you press the Down button and the Y-axis moves downwards
when you press the Up button, the keying directions of the Y-axis should be modified.

Step /ength. Or the pulse equivalent of the motor, it means the absolute distance covered by the
corresponding axis when a pulse is sent to the motor. Before correct setting of this value, you can
make the machine to cut a large rectangle (the larger figure, the less error) and the motor pace
length can be calculated automatically with the length of the figure and the measured length.

Max. speed- The driving force of the motor and the inertia of the axis of movement decide the max.
Speed of polarity of the axis. During the scan, the scanning speed should not exceed the max.
Speed corresponding to the axis of the scanning; in the cutting mode, the resultant velocity during
the cutting cannot exceed the lower of the max. Speed of the X-axis and that of the Y-axis. If the
speed is set too high, the controller will automatically protect the speed under the max speed.
Jump-off speed: the speed of the axis of movement to be started directly from the static status, if it
is set too large, the motor may lose synchronism, dither or even produce whistle, if it is set too low,
the operation speed of the entire figure will be reduced. According to the inertia of the axis of
movement, this value can normally be set at 8~15mm/s. If the inertia of the axis of movement is
too high (the axis is heavy), you can set a lower jump-off speed, while if the inertia of the axis of
movement is too low (the axis is light), and you can set a higher jump-off speed.

Acceferationr. The acceleration of the axis of movement when accelerating or decelerating, too
high acceleration will also result in loss of synchronism, dithering or even whistle of the motor,
while too low acceleration will result in slow acceleration which will reduce the operation speed of
the entire figure. A typical range of 800 ~ 3000mm/s2 can be set for an axis with high inertia,
Y-axis corresponding to the crossbeam, for instance, and a typical range of 10000 ~ 20000mm/s2
can be set for an axis with low inertia, X-axis corresponding to the dolly, for instance.

Breadth. the max. Distance that the axis of movement can cover, which should be decided
according to the actual situation of the machine.

(2) How to input a certain machine parameter?
For example, to modify the resef speed, please see Figure 1-49:
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Layer

L ..| Processing . Speed(. . Min Fow. . Max Pow. .

& I

iLaser export ii General settinzs| Machine para | Document ii Marmal ru ¢ *

Laser freg 20000, 000
Mazx Fower (%) a5, 000
Min Fower (%) Z.000

Click or double click with the right
button of the mouse

IE‘ Other parameter: TImIter Polar 1ty Negative
Home speedﬂnm;’rs: Contrl Mode Pul=zetDir
Array processing Bi-dir Ar: Kewing directior Fozitive
Eeturn position Absolute [ Step length (um) 3.750
If Protection Or Ho Max speed(mmf=) 1200.000
If blowing Ho Jump—off speedin 45, 000 B
Water protect Ha L Acceleration (mmy 10000, 000
Feeding delay (0- 5.000 b Breadth (mm) 380,000 W
= [ Find Con | [coms %|  Display ALl Layer v
27 rlce H| | ] | Beckeromd Abeut. .. |[ Close
Figure 1-49

As shown in Figure 1-49, click or double click on resef speed, you'll see a input box here, and then just
input the required value of resef speed.

(3) Open parameter files

Procedure: as shown in Figure 1-49, click on the Open button; select the parameter file to be opened from
the pop-up dialog box, and then click on the Oper button in the pop-up dialog box, then the values of the
parameters in the parameter files will be shown in the menu.

(4) Save current machine parameter to file

The Save operations can be carried out only when the Save button is activated (it is inactivated if it's grey;
this button will only be activated when there’s machine parameter read from the machine or parameter file
opened), you can click on the Save button to save machine parameters on the menu to files so as to write
parameters to the machine with the saved parameter files. Procedure: as shown in Figure 1-49, click on
the Save button, input the file name in the pop-up dialog box, and then click on the Save button in the
pop-up dialog box. Thus, the machine parameter on the menu is saved to the file.

(5) Read parameter
Procedure: as shown in Figure 1-49, select the correct USB port first, and then click on the Read button,
after a short while, if the parameter is successfully written, the menu as shown in Figure 1-50 will appear:

99



(’ User’s Manual of Laser Engraving / Cutting machine http://en.shenhuilaser.com/

Layer

L ..| Processing . Speedl. . Min Fow. . Max Fow. .

&5 e

|Laser export || General settinzs| Machine para | Document || Marmal ru ¢ *

Laser freg 20000, 000 IE‘ hxiz parameters e

Mazx Fower (%) a5, 000 hxis X

Min Fower (%] 2. 000 Direction polari Fositive
IE‘ Other parameter: Limiter polarity Hegative

Home spead (umf=) 20,000 Contrl Mode PulzetDir

Array processing Bi-dir Ar: Kewing directior Fozitive

Eeturn position Absolute [ Step length (um) 3.750

If Protection Or Ho Max speed(mmf=) 1200.000

If blowing Ho Jump—off speedin 45, 000 3

Water protect Ha L Acceleration (mmy 10000, 000

Feeding delay (0- 5.000 b Breadth (mm) 350,000 w

B — [ FindCon |[coms v|  Display|All Layer v
[(Open | [ Save || [[Read [ trite | e | remen #bout. . |[ Close
Figure 1-50

(6) Write parameter

The Write parameter operations can be carried out only when the Wrife button is activated (it is
inactivated if it's grey; this button will only be activated when there’s machine parameter read from the
machine or parameter file opened).

Operation procedure: as shown in Figure 1-49, select the correct USB port first, and then click on the
White button, after a short while, if the parameter is successfully written, the menu as shown in Figure
1-51 will appear:

Layer

L .. Proces=zing . Speedl. . Min Fow. . Max Fow. . [

< |

Laser export || General settinzs| Machine para | Document || Marmal ru ¢ *

Laser freg 20000, 000 IE‘ hxiz parameters e

Max Fower (%) 98. 000 Auis X

Min Fower (%] 2. 000 Direction polari Fositive
IE‘ Other parameter: Limiter polarity Hegative

Home spead (umf=) 20,000 Contrl Mode PulzetDir

Array processing Bi-dir Ar: Kewing directior Fozitive

Eeturn position Absolute [ Step length (um) 3.750

If Protection Or He Nax speedimmfs) 1200000

If blowing Ho Jump—off speedin 45, 000 3

Water protect Ha L Aeceleration (mmy 10000, 000

Feeding delay (0- 5.000 b Breadth (mm) 350,000 w

B | [ Find Con |cur.13 v|  Display|All Layer v

[(Open | [ Save | [ Read ||| Write ] H[107 5350 | I [[6 67 | Backgromd [bree [ Lot Close

Figure 1-51
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(7) Setting of the Sfep /ength
In the menu shown in Figure 1-49, click or double click on Sfep /fength, the menu as shown in
Figure1-52willappear:

Layer

L... Frocessing. . Speed(, . Min Fow. . Max Fow. .

| Lazer ex

\

Laser fregq 20000, 000 A IEl hxiz parametfrs ™

Max FPower (%) 95, 000 Axis b4

Min Power (%) 2. 000 Direction polaty Fositive
IE‘ Other parameter: Limiter polarits\Hegative

Heme speedimmfs; 20,000 Contrl Mode setlir _

Motor pace lengt/ button

Mrray processing Bi-dir Aoz Eeying directior Fogitive = 4 [7 g

Return position Absolute [ Step length (am) 3.180

If Frotection 01 Ho Ma speedimmf=)] 1200, 000

If blowing Ho Jump—off speedin 45. 000

Water protect Hao B | fcceleration(mmy 10000, 000

Feeding delay(0- 5. 000 v Breadth (mm) 350,000 b

[ Find Com ]lCDHS v| Display 411 Layer »
100.0 % Open Sawe Read frite
[ ] [ ] [ ] [ ] H| | Il | Rl smmnt] fbout. .. Cloze
Figure 1-52

If you know the accurate value of Sfep /ength, please directly input this value in the input box of Step
length. If you don’t know the accurate value of Step length, you can calculate it with the software
following the steps below:
(1 Draw a rectangle with specified dimensions of L * H (L for length, H for height) in CorelDraw
(corresponding to CorelDraw_Laser) or AutoCAD (corresponding to AutoCAD_Laser). This
rectangle is as shown in Figure 1-53:

Length of the rectangle: L mm

Height of the rectangle: H mm

Figure 1-53 the rectangle drawn in CorelDraw or AutoCAD
(2 Cut this rectangle with CorelDraw_Laser or AutoCAD_Laser and measure the length and height of the

cut rectangle with measuring devices I*h (I for length, h for height), as shown in Figure 1-54:

Length of the rectangle: | mm

Height of the rectangle: h mm

Figure 1-54 Rectangle formed by cutting
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3 Enter the menu as shown in Figure 1-49, click on the Read parameter button to correctly read the
machine parameters of the current machine.

@ In the menu as shown in Figure 1-52, click on the Sfep /ength button, the menu as shown in Figure
1-55 will appear:

Calculate step precision X To calculate the Step length of the X-axis, input
= the L value;
¥ | To calculate the Step length of the Y-axis, input
Geaph Length@n): [0+ | | the Hvalue.
Measuring length (mm) IZI\
—.| To calculate the Step length of the X-axis, input
the | value;
[ Ok i [ Cancel ] To calculate the Step length of the Y-axis, input
the h value;.
Figure 1-55

As shown in Figure 1-55, input corresponding Expected /ength and Actual lengih.
® Click on the OK butfon in Figure 1-55, the menu as shown in Figure 1-56 will appear:

Layer

L ..| Processing .. Speed(. .. Min Fow. .. Max Fow. .. 1]

<

iLaser export ii General settinas| Machine para | Tlocument ii Marmal ru ¥ F

IE‘ hxiz parameters

IE‘ Other parameter:
Heme speed(mmfs; 20.000
Array processing Bi—dir Arr
Retuwrn position Absolute C
If Protection Or Ho
If blowing Ha

Water protect

Ho

Feeding delay (@- 5.000

Laser freg 20000, 000 A
Max Fower (%) 98, 0oo
Min Power (%) 2.000

b

huis

~
X

Direction polari Positive
Limiter polarity Hegative
Contrl Made Ful=etDir
Kewing directior Fositiv
Step length(um) 3120

Max speed(mmfs) 1200000
Jump—off speedin 45, 000
heceleration(mmy 10000. 000

Breadth (mm)

3a0. 000

|

E

Disp)lays the calculated value of Srep lengt/z (3.1200
ere

Display 411 Layer %

[ Find Con | [coM3
H| | T|

5

| et T P

[ Open ][ Save ][ Read ]['ﬁ'rite ]

Figure 1-56

N.1.4.3.5 Document
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Layer
L ..| Processing . Speedl. . Min Fow. . Max Fow. .
-—_——-
< >
Laser export || General settings || Machine Daral Document | Marmal ru ¢ *
Document

Fumber File Hame ”~

I

2 1.rd

3 3.ord

4 4.rd

5 S.rd

-] B.rd

T T.rd b

g default. rd

a * ‘a —a i ¥

< | =

[ Dlelete ][Delete w11 ]
[ Read ]L Download " Process ]
[ Find Con | |cOM3 v|  Display|All Layer v
| H[107 6383 | T [18.4785 | Backeround Blue v [‘“"’L] [ Close |
Figure 1-57

(1) Inquiry of the Work time (h: min. s: ms).
Display format: h: min: s: ms h (hours) min (minutes) s (seconds) ms (milliseconds).
Operation procedure: as shown in Figure 1-57, select correct USB port first, and then Click on the Work
time (h: min: s: ms) button.

(2) Read
Operation procedure: as shown in Figure 1-57, select correct USB port first, and then Click on the Read
button. If files have been saved in the machine, all files saved in the machine will be shown in the menu
as shown in Figure 1-58:

Layer

L .. Proces=zing . Speed(. . Min Fow. . Max Pow. . (o)

After.readin% successfully, all files stored on the
machine will be displayed in the window

T Town
A

Eettings || Machine Daral Document | Marmal ru ¢ *

| Laser export || General

Document

File Hame
z

1.rd
Jord
4.rd
5
[}

Humber ~

.rd

.rd

T.rd
defanlt. rd

(B

IE- 2 IR K=, P

b |:Label 1: Right click on the file to select it

[ Delete ][Delete 1’.11]
]L Download ]I Process ]

[ Eead

Display |Al]l Layer %

[ Find Com

H|E=;.='=“ E383 | T |1:’s 4785

| |coms |

| Beckeromd (About. .. || Close |

Figure 1-58

(3) Download
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Operation procedure: as shown in Figure 1-57, select the correct USB port first, and then click on the
download button, then select the file to be downloaded from the pop-up dialog box, and then click on
the Open button in the pop-up dialog box.

) Delete
Operation procedure: as shown in Figure 1-58, select the file to be processed first (see the note of
label 1 in Figure 1-58), and then click on the Delete button.

() Delete all
Operation procedure: as shown in Figure 1-58, directly click on the De/efe a//button.

(6) Process
Operation procedure: as shown in Figure 1-58, select the file to be processed first (see the note of
label 1 in Figure 1-58) and then click on the Process button.

Iil.1.4.3.6 Manual

Layer

L ..| Processing .. Speed(. .. Min Fow. .. Max Fow. .. 1]

Machine para " Documentl Marmal run |Svstem Infol g

EKead Current Fosition

| 7 | |

Uni t:mm | U | o |
hxizs Run

Distanee (mm) [IMowe from origin

Speed (nmf 5] 100

seww 0 Oruiae

[ Find Con | |cOM3 v|  Display|All Layer v

H|E=;.='=“.:‘>Csz’s;s | T |1:’s.<§'=”z's':'>' | Background M [Cl'i]

Figure 1-59
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1il.1.4.3.7 System info

Layer

L. .. Processing .. Speed(. .. Min Fow. .. Max Fow. .. u]

Total on time Chewr:min:s): |

Total processzing time (howr:min: =): |

Prewvious processing |

Total lazer on time (hour min:=):

X Total traval (n):

Total processing times: |

T Total trawel im):

Mainboard wersion:

| Find Con | |cur.'|3 v| Display |All Layer

H| B4 | Beckgroma JilbiaConsial

Figure 1-60
9> Total on time: The total time of motherboard working
10>Total processing time: The total time of processing, including the time of jump moving.
11>Previous processing time: The time of the last processing
12>Total laser on time: The time of the laser processing
13>Total processing times: The number of completed processing, not include the processing forcing to
end.
14>X total travel:The total travel of motor X.
15>Y total travel: The total travel of motor Y.
16>Motherboard version: The version of the current controller.

lll Introduction of AutoCAD_Laser

lll.2.1 Features of AutoCAD_Laser
Mainly used in movement control, it is an important part of laser movement control and is. It realizes
effective control of laser numerical control machine tool by computer and accomplishes processing
tasks according to user’s different requests.
AutoCAD_Laser is a plug-in module stalled in AutoCAD, utilizing indirectly the powerful functions of
plotting and edit of AutoCAD. It supports almost all the file formats supported by AutoCAD.
lll.2.2 Environmental requirements
(O Above CPU586, above Plll or PV recommended CPU 586
@ Memory, above 1G recommended
® Windows2000/XP. Vista, XP recommended
@ Supports AutoCAD software above the version of AutoCAD2000 and AutoCAD2004.
AutoCAD2005. AutoCAD2007.

lll.2.3 Installation and startup
111.2.3.1 Installation
1. You should have installed AutoCAD software before you install AutoCAD_Laser. If you don't, please
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install AutoCAD on your computer first.
2. If AutoCAD software is opened, please close it first.
3. In order to ensure smooth installation, we suggest you to close the Anti-Virus Software first.

EICAMS e tup
V3.0 2 exe
_ VEDCAMZ.0 3.00 In. .. _ _ _ _
4. Double click on : , the software installation menu will pop up as Figure 2-1:

Welcom to use{%%1841{% H )
; gy 1. Includes two options: CorelDraw_Laser and
Install Driver/3ES)3E | L, | AutoCAD_Laser.. Select AutoCAD_Laser
Type/ZERl:  |AutolAD Laser ~| 2. Includes three options: Simplified Chinese

S m/ Traditional Chinese, English. Please selec
Larmage 185 : the software language you need.

[ Locate install path/ENEHERE

T AR i 3. Click on this button to install.

Figure 2-1 Software installation

As shown in figure 2-1, select AutoCAD _Laser, select software language, then click on the Install button, a prompt

menu as shown in figure 2-2 will pop up to show successful installation.:

RlLaserSetlip E]

\!‘:) Iristall Finish!

Figure 2-2 Prompt of instillation completion

5. Instillation completion.

lil. 2.3.2 Startup
Open AutoCAD, the main menu of AutoCAD will be shown as Figure 2-3:
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| PR CAD R AR e ine Al w | =]/E3
Eile Edit ¥iew Insert Format Toolzs [Draw Dimension Modifyr Window Help - 0 X
T = [ : - i : .
DREH 202 <0G 2 £ Leserhurning g | I50-25
= Setting i
= Yaw'aoo P r=————— ByLayer BrLaye:

Fdho 0 LIOONIC LN\ VO

i Layout! { Layout?

Hacro name: LassrlInit
Command :

Command :

Figure 2-3
(1). Click on the LaserRunning button or the LaserRunning menu item, the main menu of LaserRunning
will be shown as Figure 2-4:

Layer

L... Frocesszing .. Speedl. .. Min Fow. .. Max Fow. .. 5
e Cut 1. 000 [ 000 100, 000 [Fes

< b

Lazer export |General settingsz ||Machine para || Document | Manmal ru S

Cutting Optimized route) Seanming (Rewerse interval)
[ |Expert by the order of layers Speed (nm/ =) Rewversze ...
[¥|Inzide to outside

Single inner to outer,Find

Dj\rra}'

Height: |10 Dir: |Up to bot ¥ Fy >
DSpace Repay Optimize [ Add ] [ Del
DDriginal route Or editing rout.
Line/column setup D Feeding Count:
& Hum: 1 T Hunm: |1 Feeding Distance:
X 0] T a
DEnable center distance [Track Frame] [ Cut Frame ]

DDverall handle e
[ Bestrewing breadth. .. ] Fosition |Current positi ¥ COM3 bt Display |All Layer %
[ SavaTollFile ][ 1Filelut ][Pausefcontinue ][ Stop ][ Process ] H T Background |White hd

Figure 2-4

Note: this menu will not pop up when AutoCAD is not plotting at present.
(2). Click on the Setup button or the Setup menu item, the dialog box of Setup will pop up as shown in Figure
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Setting §|

2-5:

File Format:

Curwe Precsion (%)

(*)DXF - AutoCAD Files

|:| Output Text:

Delete Repeated Track:

’ Pazszword Setting. .. ]

[ 0K § [Ca.n-:el ]

Figure 2-5

2.1 Operation instruction of AutoCAD_Laser. (AlImost the same to that of CoreDraw_Laser please refer to
the operation instruction of CorelDraw_Laser).
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lll Attached

Bitmap Creation Flow

Step one: Startup Photoshop

3

Step two: Select the menu File/Open to open a picture:

figure 5-1

Step three: Sclect the size and the precision of the picture

1. Open the menu Image/Image Size, a window will pop up, as shown below:

Image Size

Pxel Dimensions: 1.57M

ikl

0K
width: pixels v ]@ Raset
Height: | 800 ixel b

I—I pixels Auto...

Document Size:

I
(i

Width: | 24.24 m v :|

Height: | 28.22 cm w

T

Resolution: | 72 pixelsfinch  »

Scale Styles
[¥] Constrain Proportions

Resarmple Image: | Bicubic b

Figure 5-2

2. In the column Document Size/ Height and Width, input the value you wanted, figure 5-3 followed;

3. In the column Document Size/ Resolution, input the converted graph precision(600~1200 pixels per inch is
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recommended, the higher resolution, the clearer converted graph);

Image S5ize

Piel Dimensions: 53.2M (was 1.57M) 0

3

Width: | 3937 pixels v

Height: | 4724 picels e
Document Size:

Width: [ 10 cm M

Height: | 12 crm >

Resolution: | gy pixelsfinch %

Dgunstmin Proportions

<

Resample Image: | Bicubic

figure 5-3

Such as figure 5-3: the converted graph size is 10cm*12cm, the resolution is 1000 pixels per inch;
4. Push on the OK bottom.
Step four: Select the menu Image/Mode/Grey Scale, take out the color information.
Step five: To create net-dot bitmap, two methods are discussed below:

Method one:
1. Select the menu Image/Mode/Bitmap, a window will pop up as below:

X
Resolution
[_cancel |

Input: 1000 pixels/inch
_Cancel
Qutput: | 1000 piels/inch b

Method

Bitmap

Use: | Halftone Screen... w

50% Threshold
Pattern Dither
Diffusion Dither

figure 5-4
2. Select (T) , (P) , (D) or (H) , which method is you wanted,;
3. To solid graph, Please select (T) , to create some scan graph of the character or of the logo design. To cross line

graph, may select one of (P) , (D) or (H) , to create some different effect. Generally speaking, select (H) .

4, if (H) selected, a window will pop up:
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Halftone Screen [5_<|

Halftone Screen

figure 5-5
In this window, frequency (F) , that’s to say, the precision of the cross line, may be 10~60 lines per inch;
Angle (N) may be 45 degree;
In column Shape (H) , circle is selected generally.
5. Push on the bottom OK.

Method two:
1. Select Filter/ Pixelate / Color Halftone , a window will pop up, such as figure 5-6.
2. Confirm Max Radius, which is 4~127 pixels, to confirm the size of the color halftone gridding. The calculating
method followed: graphics resolution*0.71/ gridding precision.
For example: as shown in figure 5-1, the resolution is 1000 pixels per inch, the wanted gridding precision is

60 DPI, then, the max radius is 12, the expression followed: 1000*0.7/60=12.
3. Confirm the net angle of the graph channels.

Input the net angle value for some of the graph channels, the angle is -360~+360 degree, which is the angle of
the net dot and the horizontal line.

Note:

To grey graph, only channel 1 selected,

To RGB graph, channels 1,2 and 3 selected, then red, green and blue channels are corresponding;

To CMYK graph, all four channels selected, then cyan, magenta, yellow and black channels are
corresponding.

Color Halftone E'

Mani, Radius: (3 | (Pixels)

...........

Screen Angles (Degrees):

Channel 1:
Channel 2:
Channel 3:
Channel 4;

4. Push on the OK bottom;
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5. In the menu Image/Mode/Bitmap, Select 50% Threshold, to convert the graph to one-bit bitmap.

For example, after filter processing, the RGB graph, such as figure 5-7-1, will be converted to a bitmap, as

shown in figure 5-7-2.

figure 5-7-1 figure 5-7-2

(1)Select Image/Rotate Canvas/Flip Horizontal to rotate the graph;
(2)Select the menu File/Save As to save the graph file, BMP format selected;
(3)All things are done.
Some methods of drawing in Photoshop aren’t discussed in this file, if needed, please consult the Manuals

of Photoshop or some related books.
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IV Specification of MC-BOARD Motion
Control Mainboard Interface V3.00

IV.1 Overview

MC-BOARD mainboard is specially used in the motion control system for laser engraving and cutting,
which can support the motion control of four shafts at most, that is, the gang control of two shafts and the
inching control of the other two shafts. The gang control system of 3 or 4 shafts can be developed for
specific users.

MC-BOARD mainboard supports both the online control mode and the offline control mode, which,
after the parameter setting, graph edition and path optimization of machines (For details, see the
description of mainboard PC software) can be completed with the supporting PC software of this
mainboard, can be started and processed in PC, or generated into data files (.rd) in PC and copied to the
mainboard memory through U-disk so as to realize offline operation. This mainboard supports FAT32 and
FAT16 file formats of U-disk in addition to copying of .rd file in the mainboard memory into U-disk.

MC-BOARD is equipped with a man-machine operating panel that is connected to RS232 interface
and the mainboard.

Please pay attention to the following items when using this mainboard:

Please read this Specification prior to use of this mainboard;

Please don’t dismantle and change the chips and components on the mainboard on your own;
Please keep it far away from water and corrosive substances;

Please don’t press the chips and components with force in the process of wiring or installation.

L 2R 2R 2R 2
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IV.2 Installing Dimensions

IV.2.1 Installing Dimensions of Mainboard
All the dimension units are expressed in mm to the accuracy of 0.1Tmm.

1o O OH=x---
::::'"é Eb: ;@"‘!""

R
--Y__

IV.2.2 Installing Dimensions of Keyboard
All the dimension units are expressed in mm to the accuracy of 0.1mm.

' — 38

v
 ¥o Oly- [
- XX - —

---Y__
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IV.3 Physical Picture and Interfaces
IV.3.1 Physical Picture of MC-BOARD Mainboard

D16~D20
D16 means the
system flashers.

Udisk L-P2 L-P1 10 Pl

LU LT

ididided

JP3
JpP2

Bilbidi iy

- B e .I._gg,.l AT

i B

PC ‘ Z/U-Lim X/Y-Lim
D14~D11
U/Z Limit D10~D7
i i H . Indication ?(/;( LI;TIIt
IV.3.2 Physical Picture of Main-Machine Panel ndication
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IV.4 Description of Interface Signal

IV.4.1 Power Interface JPO (4pin 3.81mm)

Pins Definitions

1 24V GND (Input)
2 24V VCC (Input)
3 5V GND (Input)
4 5V VCC (Input)

€ This mainboard uses 24V and 5V power supply, of which quality should be guaranteed. Please pay
attention to the sequence of all interface pins, with the serial numbers marked on the mainboard.

IV.4.2 USB Interface

There are two USB interfaces on the mainboard. One is marked as the Udisk interface used in
insertion of U-disk as well as copying of U-disk files and memory files; the other is marked as PC interface
used to connect PC to facilitate parameter setting and control of mainboard through PC.

IV4. 3 4-axis Limit Interface (6pin 3.81mm)

Z/U-axis Limit Interface Z/U-Lim

Pins

Definitions

5V GND (Output)

U-, U-axis moves to the limit of 0 coordinate, and corresponds to D14 indicator.

U+, U-axis moves to the limit of the maximum coordinate, and corresponds to D13 indicator.

Z-, Z-axis moves to the limit of 0 coordinate, and corresponds to D12 indicator.

Z+, Z-axis moves to the limit of the maximum coordinate, and corresponds to D11 indicator.

DB IWIN|~

5V-1K resistor pulled up or 5V is selectable (Output); when JP3 jumps across Pin 1 and 2,
Pin 6 is 5V; when JP3 jumps across Pin 2 and 3, Pin 6 is 1K resistor pulled up to 5V.

X/Y-axis Limit Interface X/Y-Lim

Pins

Definitions

5V GND (Output)

Y-, Y-axis moves to the limit of O coordinate, and corresponds to D10 indicator.

Y+, Y-axis moves to the limit of the maximum coordinate, and corresponds to D9 indicator.

X-, X-axis moves to the limit of O coordinate, and corresponds to D8 indicator.

X+, X-axis moves to the limit of the maximum coordinate, and corresponds to D10 indicator.

DO WIN|~

5V-1K resistor pulled up or 5V is selectable (Output); when JP2 jumps across Pin 1 and 2,
Pin 6 is 5V; when JP2 jumps across Pin 2 and 3, Pin 6 is 1K resistor pulled up to 5V.

@ In the PC software of this mainboard, you can select the support to the limit polarity, that is, if the axis
moves to the limited position, it will trigger a low-level signal, and the LED corresponding to each limit
will light up; when the axis moves far from the limited position, it will trigger the high-level signal and
the limit indicator will go out. On the contrary, if the axis moves near to the limit, it will trigger the high
level; if it moves far from the limit, it will trigger the low level and the limit polarity is plus.
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IV.4.4 X/Y/ZIU Moving Axes Driver Interfaces (X. Y. Z. U 6pin 3.81mm)

The four moving axes have the same interfaces. X-axis interface is taken for example.

Pins Definitions
1 5V GND (Output)
2 XDIR+
1. If the motor driver uses the pulse + direction control mode, the pin should be connected
to the direction control port of motor driver;
2. If the motor driver uses the double-pulse control mode, the pin should be connected to
the opposite pulse input port.
3 XDIR-, reserved
4 XPWM-, reserved
5 XPWM+
1. If the motor driver uses the pulse + direction control mode, the pin should be connected
to the pulse input port of motor driver;
2. If the motor driver uses the double-pulse control mode, the pin should be connected to
the positive pulse input port.
6 5V VCC (Output)

@ If the power system of the mainboard resets and either of X/Y axes moves reversely, it means the
directional signal of this axis is not right in polarity. In such a case this axis should be disconnected
from the motor driver (otherwise the mainboard can’t detect the limit so as to cause the collision of this
axis) first, and then such a polarity be corrected on PC after D16 on the mainboard flickers (it means
resetting is completed, because D16 will go out when the machine resets each time, and it can start
flickering only after resetting. Please don’t read any parameters on PC before D16 doesn'’t flicker). The
resetting of the mainboard can be done through pressing the RESET button, the directional signal
polarity of this axis having been corrected on PC.

IV.4.5 Man-machine Operating Panel Interface P1

P1 is DB9 mother socket connected to the man-machine operating panel. Both are communicated
with RS232.

IV.4.6 General Purpose Input/Output (GPIO) (5pin 3.81mm)

Pins Definitions

1 5V GND (Output)

2 GPI 2 is inputted from the protection notch. Where the machine needs protection in the
specific state, the protection signal should be inputted from this pin that can be enabled and
disabled. This pin being disabled, this signal will not be inquired by the mainboard; this pin
being enabled, the machine will be protected when the input is at a high level, all operations
be suspended and the laser closed.

3 GPI 1 is temporarily reserved for future use.

4 GPO 1, Output high level when work start and output low level when work pause or finish.
This port can autocontrol some equipment such as blower, which can be opened when
work start and closed when work pause or finish.

5 5V VCC (Output)
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IV.4.7 Laser Power Supply Interface (6pin 3.81mm)
Digital Laser Power Supply Interface L-P1

Pins | Definitions

1 Laser power supply 5V GND (Output)

2 LSWITCH-, Laser Enable Control Interface

1. The laser being a RF laser, this pin will not be used;

2. The laser being a glass tube, this pin will be connected to the laser power supply enable and
used in ON/OFF of laser control if this laser power supply device emits light at low level.

3 LSWITCH+, Laser Enable Control Interface

1. The laser being a RF laser, this pin will not be used;

2. The laser being a glass tube, this pin will be connected to the laser power supply enable and
used in ON/OFF of laser control if this laser power supply device emits light at high level.

4 LPWM+, Laser/Tube Power Control Interface

1. The laser being a RF laser, this pin will not be used;

2. The laser being a glass tube and the laser power supply PWM effective at high level, this pin
will be connected to the laser power supply PWM and used in control of laser power.

5 LPWM-, Laser/Tube Power Control Interface

1. The laser being a RF laser, this pin will be used in control of laser ON/OFF and power;

2. The laser being a glass tube and the laser power supply PWM effective at low level, this pin
will be connected to the laser power supply PWM and used in control of laser power.
6 Laser Power Supply 5V VCC (Output)
Simulated Laser Power Interface L-P2
Pins | Definitions

1 Laser Power Supply 5V GND (Output)
2 Simulated Voltage 1 is connected to the power control of simulated laser power supply.
3 Simulated Voltage 2 is connected to the power control of simulated laser power supply. It can at

most be connected to two ways of simulated laser power supply to control two laser tubes. The
power of such two laser tubes can be matched through adjustment of potentiometer VR1 and
VR2.

4 The water-protecting state input has its corresponding indicator D15. Where the system
configuration is the RF laser (select the digital control or digital control + pre-ignition in the

options of laser type in PC software), the mainboard will not check the water protecting input.
When the system configuration is the glass tube (select the analogue control in the options of
laser type in PC software), the mainboard will always detect the water protecting input. If this
input is of low level, it should be deemed as normal (D15 lights up); if it is of high level (D15
goes out), the mainboard will close the laser forcibly. In such a case, when the configuration is
the glass tube, please connect it to the water protecting input correctly.

5 Laser Power Supply 5V VCC (Output)

6 1K resistor is pulled up to the laser power supply 5V VCC. (Output)

€ The supporting PC software of this system supports laser. Where the glass tube is provided, please
select the “Analogue” in the options of laser type; where the RF tube is provided or there is pre-ignition,
please select the “Digital Quantity/Pre-ignition”. Altering the options of laser type, please
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V Instruction on the Machine Parts

1. X axis limit switch
2. Y axis motor

3. Y axis shaft joint
4. X axis motor

5. Y axis limit switch
6. Current Indication
7. Control Panel

8. USB Interface

9. Control Switch
10.Up and Down Switch
11.Laser Switch
12.Red light indicator

13.Laser head
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. 220V Input for machine
. Ground wire joint

. 220V Input for laser

. Water Inlet

. Water Outlet

. Air Inlet
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(|

. 24V power supply for mainbaord

. 5V power supply for mainbaord

. Mainbaord

. 36V power supply for motor driver
. X axis motor driver

.Y axis motor driver

. Laser power supply

. Electrical resistence
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1. Water sensor switch

Thank you for buying Shenhui laser machine sincerely, if you have any

other problem, please contact with us without hesitate!
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